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Introduction

Welcome to OPENBook. OPENBooOK is a software program
that turns your PC, scanner, and sound card into a full-
featured reading machine. Scan a page using a flatbed
scanner, and OPENBook will read that page aloud to you.
Or, open and read a text or word-processing file!
OPENBook lets you alter the way the page is read aloud to
you or, if you have low vision, modify the way the page is
presented on the screen.

This newest version of OPENBook comes with a host of new
features, many of which were requested by our users. Email
was the biggest request, and we have added that.
OPENBook now includes page layout analysis, description,
and navigation. It can tell you how many columns, headings,
pictures, and other elements are on each page. Plus, you
can move from element to element. And there are many
other new features, including the ability to save just the
current scanned page or a range of pages.

If you want to read faster and more easily, OPENBooOK is for
you!

Low Vision Users

OPENBook includes many features specially designed for
low vision users:

Exact View lets you scan and display a page on the screen
exactly as it is in the original document, including graphics,
columns, and other elements that affect how the page looks.



Zoom allows you to change the display of the scanned page
from 25% of normal size to 500% of normal size.

Color Combinations lets you select text and background
color combinations to make it easier to see the text on the
screen.

Visual Settings gives you control over the font type and
size, text, background, and cursor colors, the margin size,
and spacing between characters, word, lines and sentences
-- all to make the page more readable.

Documentation Conventions

Please note a few of the conventions used in this
manual:
* When introducing menu items, their hotkey
combinations are indicated in brackets.
* When describing dialog boxes or property pages, each
element in the box will be described in the order you
encounter it when tabbing through the box.

How Do | Get Help?

There are several ways to get help when you are using
OPENBook.



Help Topics

You can read any part of this manual using the OPENBook
Help topics. To access this feature, press ALT+H, that is,
hold down the ALT, and press the H key, to open the help
menu. There are two menu items, Search for Help On and
the Table of Contents. Move to the item you want and Press
ENTER.

If you are looking for general information, you will want to
use the Table of Contents, but if you know the specific
feature, such as how to exit OPENBooK, select Search for
Help On and type in the keyword, i.e., Exit. This will move
you through the list to the topic you want. Use the ARROW
keys to move through the complete index to find the topic
you want. Once you have made your selection, press
ENTER.

When you do this, OPENBook opens the selected section of
the manual and displays it on the screen. You can read this
help topic exactly as you would any other document. Press

the PAGE DOWN key to hear more in the help topic.

Status Bar Help

When you are on a menu in OPENBooOK, the Status Bar at
the bottom of the screen provides a short description of each
menu item. To hear status bar messages, press
SHIFT+CTRL+F10, that is, while holding down the SHIFT
and CTRL keys, press the F10 key, located on the very top
row of the keyboard.

Context-Sensitive Help



When you are in a dialog box, the F1 or the KEYPAD MINUS
key read the context-sensitive help message for the current
item.

You can also access Context-sensitive Help with a mouse
with a right click or by clicking on the ? (question mark)
symbol at the top right corner of the dialog box.

The Readme File

OPENBook's README file gives you the latest technical
information. You can open and read the README file using
Help Topics, which are listed on the Help menu. Access
Help Topics by pressing ALT+H.

Technical Support
Reach Technical Support using the following options:

Automated online Help: Technical Support Department
World Wide Web: link
http://www.FreedomScientific.com
Technical Support e-mail: SoftwareSupport@FreedomScientific.com
Technical Support Telephone: (727) 803-8600

When you call, be at your computer, have your
documentation in hand, and be prepared to provide the
following information:

Product serial number used for registration.
Product name and version number.

Type of computer hardware you are using.
Software version number of Windows.



Exact wording of any messages that appear on your
screen.

What you were doing when the problem occurred.

How you tried to solve the problem.

Office hours: Monday through Friday 8:30 A.M. to 5:00 P.M.
Eastern Time (USA)

Getting Started

What You Need to Run OPENBook

The minimum system requirements to run OPENBook are:

An IBM-compatible Pentium or higher computer
Windows 95, Windows 98, or Windows NT 4.0
32 megabytes of RAM

A CD-ROM drive

200 megabytes of available hard disk space (plus room
for document storage)

A standard keyboard

An SSIL-supported speech synthesizer with speaker, or
a SoundBlaster 16-compatible (or better) sound card
with speaker

A supported TWAIN-compatible scanner or a supported
Hewlett-Packard flatbed scanner



Low vision users may prefer to use OPENBook with a
monitor, or with a monitor and a speech synthesizer. You
can also use a Microsoft-compatible mouse or other pointing
device. We recommend the following if you are using
OPENBook with a monitor:

A video card and monitor capable of VGA video in
640x480, 256 color mode, or greater

Optional components include:

A mouse or a Logitech WingMan Force Feedback
Mouse, to give tactile feedback for page layout

A modem, DSL, or network connection, plus an ISP
(Internet Service Provider), to give you access to
OPENBook's new email feature

Installing OPENBook

The OPENBooOK Installation program installs the program
and creates folders for user documents and settings. It also
checks to see if you have a sound card. Finally, the
Installation program places the OPENBook icon on the
desktop and creates an easy-to-use hotkey to start
OPENBook.



Before you install:
Turn on your PC.

Install and turn on your scanner, making sure that it is
unlocked. (Your scanner must be separately installed
using the CD that comes with the scanner.)

Have your software serial number handy. The serial
number is located in two places: on the outside of the
box and on the outside of the plastic case that holds the
OPENBook CD.

Using the Talking Windows Installation

OPENBook's Installation program talks, making it easy for
you to hear the prompts.

If you need help moving through the dialog boxes that
appear during installation, see the section later in this
chapter titled "Using Dialog Boxes."

You will be given an option to use your own screen reader if
OPENBook detects one installed in your system.

Starting the Installation Program

To begin the installation procedure, place the OPENBook
CD in your CD-ROM drive. OPENBook automatically starts
the installation process.



If, for some reason, OPENBook does not automatically start
the installation process, follow these steps:

With the OPENBook CD in your CD-ROM drive, open
the Windows START menu on the task bar.

Select RUN.

In the Edit Field, type in the name of your CD drive
(usually d:\), followed by the word SETUP (for example,

d:\setup).

Select the OK button in the RUN dialog box, or press
the ENTER key.

You can exit the OPENBook Installation program at any
time, simply by selecting CANCEL.

Once installation begins, follow the prompts to install
OPENBook. OPENBook will ask whether you want to do a
typical or custom installation.

Typical

This installation installs all the default files to run OPENBook
along with the ViaVoice Outloud speech synthesizer
software, which is included on your OPENBook CD. If you
want to use a different synthesizer, you must select the
Custom installation. The Typical installation also installs
standard launchable programs.



Custom

If you are going to use other synthesizers, or if you want to
install OPENBook in a different directory, select Custom and
you will be given a chance to install these choices.

Note that the newest version of OPENBook automatically
detects your scanner, so it is no longer part of the installation
process.

Starting OPENBook

From the Windows desktop, you can use the OPENBook
hotkey, ALT+CTRL+O, or you can use a mouse to double
click on the OPENBook icon.

Using A Windows Application

OPENBook is a Windows application program, and many
features will be familiar to you if you are a Microsoft
Windows user. If you're new to Windows, don't worry! This
section will help you learn how to work with Windows
features.



When you use Windows programs such as OPENBook with
a speech synthesizer, OPENBook will focus on the text at
the cursor location, allowing a user to hear the feature if they
cannot see it.

Or, if a keystroke is pressed OPENBook will speak it or the
resulting action.

There is always more than one way to do things in Windows.
You can:

Use the Keyboard Commands
Use the Menus
Use the Mouse

Note: The Classic Menus are also available for users who
prefer to use them. Select the topic listed on the Help Menu
to see all of the details.

Press KEYPAD PAGE DOWN to see more about these
commands.

Keyboard Commands

You can work in Windows applications such as OPENBook
using keystroke combinations, sometimes called Hotkeys or
Keyboard Commands. These keystrokes use a combination
of the Function Keys F1 through F12, which are on the top



row of keys on the keyboard. For example, F1 brings up the
Help Topics in almost all Windows programs.

Function keys can also be combined with special keys to
provide more features, such as ALT+F4, which closes most
Windows programs.

The special keys that are used are: ALT, CTRL, SHIFT,
ESC, DEL, INSERT, ENTER, and others.

These special keys can also be used in combination with
letters assigned to features. For example, CTRL+S will save
the current document without closing it.

For a complete list of keystrokes, go to the Keystrokes
section later in this Help file.

Using Menus

All menus and functions listed have a letter assigned to
them. For example, the File Menu has the letter "f" assigned
to it. Use these letters in combination with the ALT key
(which is written as ALT+F in this documentation) to open
the menu. You can then use another letter to move down to
the menu item you want, or use ARROWS to move through
the choices.

You access Windows menu items by pressing the ALT key.
Then use the RIGHT and LEFT ARROWS to move back and



forth from menu to menu. Use the UP and DOWN
ARROWS to move up and down in the menu, from item to
item.

You can also access a menu by pressing ALT along with the
assigned shortcut letter in the menu's name. For example,
press the ALT key plus the S key to get to the Scan menu.
This letter is underlined on the screen. Additionally, any
keyboard "hotkeys," such as key combinations (CTRL+O) or
function keys (F4) associated with the menu item, are
displayed on the menu. In its default setting, OPENBook
does not announce these shortcut keys and hotkeys. You
can change this by typing the following series of commands:
ALT+G, G, ALT+K. After you press ALT+K, OPENBook
should say "Announce Shortcut Keys: checked."” Now press
ENTER. If you ever want to turn this feature back off, follow
the same sequence. OPENBook should say "Announce
Shortcut Keys: unchecked" when you press ALT+K this time.

The shortcuts for OPENBook's menus, in order, are:

F for File

E for Edit

S for Scan

V for View

T for Tools

G for Settings

L for Low Vision
W for Window
H for Help



Please note that when you first open the software, some
menu items will not be available. If an item is not available,
its text will appear grayed, and OPENBook will describe that
item as "inactive." Once you open or scan a document,
additional menu items become available.

Finally, some menu items have alternate options, for
example, Show Exact View and Show Text View. Only one
option shows on the menu at a time.

Using Dialog Boxes

Keystrokes

There are a number of elements that you will encounter in
various Windows Dialogs.

To move to the next element TAB

Move to the previous element SHIFT+TAB
To hear the dialog box read CTRL+B

To stop speech CTRL

To cancel and close the dialog box ESC

To activate a Button ENTER

To check or uncheck a Check Box SPACEBAR
To work in an Edit Field Type the text.

To read Information and List Fields ARROW keys
To select an item in a List Field ENTER



To quickly move in List Field Type first letter
of item

Note: This will move to the first item in the list that
starts with that letter. Use ARROW to find the exact
item you want.

To move through Radio Buttons ARROW keys
To move off Radio Buttons TAB

Using A Mouse in a Dialog

If you are using a mouse in a Dialog Box, you can click
directly on any option in the box to select it. Sometimes you
will then need to click on the OK button. At any point on the
dialog box, you can click on the CLOSE or CANCEL button,
or on the small box with an Xin it at the top right corner of
the dialog box.

To use Edit Fields using a mouse, click once and an
Insertion Point appears in the form of a blinking vertical bar.
You can start typing text at that point. When you stop typing,
the Insertion Point reappears.

List Fields

For fields with a list of pre-selected options (List Fields), click
on either the field or the arrow to the right of the field, to
reveal the list. Then click on the desired item.

Radio Buttons



These come in pairs or groups. You must select one and
only one of the options. Click to select the desired option.
Each time you click on a new option, you automatically
select that option and the others are deselected.

To Select Text

To use certain OPENBook menu features -- such as Copy or
Delete -- you need to first select (or "highlight") the text you
wish the feature to act upon. Once the cursor is on the first
word you wish to select, use the mouse to select the text.

Registration

Once you have completed the installation of OPENBook, you
are ready to register your software license with Freedom
Scientific.

Taking the time to register your OPENBook software helps
us to help you. Once we have received your contact
information and serial number you will be a registered
OPENBook user. This means that you can receive technical
support, and that your software can be more easily replaced
if it is damaged, lost, or stolen. Failure to register your
software hinders our ability to provide you with the best
possible service. Please register today!

To register:



1 Place the Registration disk in your disk drive.
2. Start OPENBOooK if it is not already running.

3. Go to the File Menu and select Open or press CTRL+O.
4. Type in the Filename edit box, a:\registration.ark, and
then press ENTER.

5. The registration document will open.

6.

Press CTRL+E to toggle to the Edit Mode in
OPENBook.

7. Use you arrow keys to move down the screen. Please
fill in the information requested.

8. When finished, save the information by pressing
CTRL+S.

Note: To save a copy of this form on your computer,
press ALT+F, A (for Save As) and then press ENTER. This
saves a copy of the same file in the My Documents folder on
your hard drive.

9. Please send the disk to Freedom Scientific in the self-
addressed postage-paid disk mailer included in the software
package. The cardboard disk mailer has the name Freedom
Scientific embossed in Braille.

Scanning

See also: Scanning Settings.



Scan Menu [ALT+S]

This menu lets you control how OPENBook scans, and
displays the page after scanning it. If you do not have a
scanner installed, items on this menu may not be available.

Scan a Page [INSERT, SPACEBAR, or F4]

Select this menu item to begin scanning the page you have
placed on the scanner. The SPACEBAR and the INSERT
key on the numeric keypad can also be used as Scan keys.

OPENBook provides a number of ways to scan and read
text, all of which can be set using the Scanning Settings,
located on the Settings menu.

During the scanning process, OPENBook will give you
progress reports and prompt you for action using the Scan a
Page dialog box. This box includes the following items:

Scanning Image field

Tells you when this stage of the scanning process is
complete.

Preparing Image field
Tells you when this stage of the scanning process starts.



Recognizing Text field
Tells you when this stage of the scanning process starts.

Place the page to be scanned on the scanner first, and then
begin scanning.

Note: There is a CANCEL button in the dialog box. If
you cancel scanning, there may be a slight delay before
OPENBook interrupts the scanning process.

When you scan subsequent pages, OPENBook inserts them
at the end of your document (no matter where your cursor
is).

Scan and Replace Current Page

Select this menu item when you are in a scanned document,
to scan a page and have it replace the current scanned
page. This function is useful if you are reading a document
and come to a page that seems to contain nonsense words
or symbols, indicating that the first scan may have had errors
or the page may have been skewed. Scan and

Replace Current Page lets you re-scan that page and put it
in the right place in your document.

Note: When you are doing 2-page Scan and Replace, this
replaces both facing pages of the 2-page book: the current
and the next page.

Scan and Insert New Page

Select this menu item when you are in a document, to scan a
page and have it inserted before the current scanned page.



You can insert a new scanned page in any document,
including a word processing file. This tool lets you insert
pages at any location in the document.

Note: When you are doing 2-page Scan and Insert, this
inserts two new pages in your document: both facing pages
of the 2-page book.

Scan Preview [SHIFT+F4]

Select this menu item to get a quick idea of what is on a
page. OPENBook will scan just the first couple of inches
and quickly read the results to you. If you then want to
perform a full scan on the page, press ESC, then press the
Scan key. If you want to preview another page, press
SHIFT+F4 again.

BuckScan [CTRL+M]

Select this menu item to scan currency and learn the
denomination. Place the bill horizontally on the glass plate
of the scanner, making it square against the raised rims on
the right and rear edges of the glass. If you have an HP
flatbed scanner, make sure the long side of the bill is against
the top edge of the glass plate. If you have a TWAIN
scanner, make sure the long side of the bill is against the
front and left edges. Press CTRL+M or select BuckScan
from the Scan menu. OPENBook will scan the bill and tell
you the denomination. BuckScan will scan and identify
American or Canadian currency.

Recognize Columns



Select this item to determine how OPENBook will handle
reading a page with columns. This menu item is checked by
default. To check or uncheck this item, move to the item on
the menu, and then press the SPACEBAR. \When checked,
OPENBook will read down columns of text (like in a
newspaper). When this item is not checked, OPENBook will
read across columns of text (like in a table). Use Recognize
Columns to read a standard page (single column), or to read
multi-column pages.

Color Scanning

Select this menu item to scan pages of colored text, art, and
photographs in color. Black and white text, art, and
photographs will continue to be scanned in black and white.
When you start OPENBooKk, this selection is not checked.

To check or uncheck this menu item, move to the item on the
menu, then press ENTER. If you do not have a color
scanner installed, OPENBook will tell you that color scanning
is not possible, and continue scanning in black and white.
Color scanning takes significantly longer, so use color
scanning only when you have sufficient time to process the
scans.

2-page Scanning

Select this menu item to scan two side-by-side pages of an
open paperback book or other book whose facing pages can
both fit on the scanner glass. OPENBook will store the
pages separately, with separate page numbers. This allows
the page numbers in your document to match the page
numbers in the scanned book. After scanning, OPENBook
will automatically read the first page first, and then read the



second page. When you start OPENBoOK, this selection is
not checked. To check or uncheck this menu item, move to
the item on the menu, then press ENTER. If you do not
have a scanner installed, this menu item is not available.

Scan for Accuracy / Scan for Speed

The following two scanning features are alternate options.
You can select only one of the options, and when you do, the
other is automatically de-selected. To check an item, move
to it on the menu, then press ENTER.

Scan for Accuracy is checked by default on startup. When
checked, OPENBook scans the document using the highest
degree of scanning accuracy, along with other special
scanning features. However, accurate scanning does take
longer.

Scan for Speed is not checked on startup. When checked,
OPENBook scans the document faster, but some degree of
accuracy may be lost.

Questions About Scanning

After pressing the Scan button, OPENBook doesn't scan
or talk. What should | do?

Please note that some HP scanners may take up to 30
seconds to warm up before scanning the first time in a
session. Subsequent scans will not have this delay.

1. Check to see if the scanner is on. You should be able to
hear the scanner "start up" when you press the power
switch. There is also a green indicator light in the front.
When the scanner is on, this light is illuminated.



2. Turn off OPENBook and shut down your PC.

3. Check both the power cable and the scanner cable on the
back of the scanner. They must be on tight to work

properly.
4. Next, follow the scanner cable to the back of your PC and
check the connection.

5. Also make sure that the scanner is unlocked. Scanners
have a locking mechanism that is engaged when the
scanner is shipped. You cannot run any scanning
programs without unlocking the mechanism, and you
may break the scanner if you repeatedly turn it on while
locked. For more information on how to unlock your
scanner, see the instruction page included with your
scanner,

6. Restart your PC and OPENBook

7. If this doesn't solve your problem, please contact your
dealer or Arkenstone.

What if | scan a page and it is not reading the columns
correctly?

Try turning off the Recognize Columns setting, then re-scan
the page. Although most pages scan and read best using
the default setting, Recognize Columns, other pages may
improve with Recognize Columns turned off.

Can | correct mistakes made by the scanner?

Yes, you can make changes and corrections while you are in
Text View, but not while you are in Exact View. You can use
OPENBooK's editing capabilities to correct errors that you
find in Text View, then save the corrected document. In
Exact View, the scanner is actually taking a picture of the



page, which OPENBook then displays in Exact View. You
cannot modify this picture.

How do | get better recognition from my scanner?

You can start by using the Most Accurate Scanning setting in
the Scan Menu. This setting takes longer, but uses the
highest degree of scanning accuracy. You can also try
adjusting some of the settings in the Scanning Settings
property page, found on the Settings menu.

| am missing some letters in each line when | scan a
book. How do I fix this?

If you are missing letters from the beginning or end of each
line, you may not have the book correctly placed on the
scanner. Make sure to line up the edges of the book with the
edge of the scanner's glass plate. This result can also occur
if you fail to press down firmly on the book's binding when
you are scanning it.

Automatic Document Feeders

Can | use an automatic document feeder (ADF) with my
scanner?

Yes, but you must scan pages in the order you want them to
appear in your document. If you are scanning a 2-sided
batch, the backs of the pages should be scanned in reverse
order.



If | purchase an ADF after | install OPENBook, will | need
to reinstall the program?

You will not need to reinstall OPENBook when you add an
ADF to your scanner. Exit OPENBooK, turn off your scanner,
and install the ADF. Make sure to plug it into the scanner
properly. When you turn on the scanner and run
OPENBook, the scanner will tell the software that it now has
an ADF. To use the ADF, just place your pages in it.
OPENBook will change how it prompts you to insure that you
get complete use of the ADF. You may also continue to use
the flatbed.

Please note that if you have an HP5100 scanner purchased
before July 1998, you will need a software upgrade from HP
before you can use the ADF.

How do | scan a document that has more pages than the
ADF can hold at one time?

Separate the stack of pages into smaller groups (typically 20
to 25 pages) and scan all of the "fronts" of each page in each
group. If you need to scan the "backs" of the pages, wait
until prompted. Select "Turn Pages Over" and scan all of the
"backs" in each group, starting with the last group, until all
pages in the stack are scanned. OPENBook will
automatically collate all pages.

How do | scan the next page when | am using the ADF?

After you have finished reading the page, press Scan. If
there is another page in the ADF, OPENBook will scan the
page automatically.

What do | do if | get a paper jam with my automatic
document feeder?



Occasionally some scanners experience a paper jam in the
document feeder that halts everything -- OPENBook stops
reading and says "Paper Jam." If this situation occurs:

1. Exit OPENBooOK.
2. Turn off the PC and scanner, in that order.

3. Remove the paper from the scanner, making sure that no
paper clips or staples have gotten stuck in the automatic
document feeder.

4. Turn on the scanner first, and then turn on your PC.
5. Start OPENBooOK.
6. Resume scanning.

Reading

Working with Files

To help computer users keep their work organized, Microsoft
Windows uses files and folders, just like someone in an
office might use paper versions of files and folders. One
drawer in a file is reserved for work in progress, while
another is just an archive. Each folder in these drawers
relate to one topic, while there may be many documents
inside. This section will discuss using the File Menu
commands to control the files, folders, and documents on
your computer.

Note: If you create files using a word processing program or
other application, those files will be saved in the appropriate
location for that application. This will probably not be the



same place that your OPENBook documents are stored.
Use the Folders field to go to the folder that contains your
other documents. After you open a file, you can save it to
your OPENBook Library or any other location.

File Menu [ALT+F]

This menu allows you to open, save, print documents, or quit
OPENBooKk.

New [CTRL+N]

Select this menu item to create a new document. When you
select New, OPENBook opens a document and names it
"Untitled."

Open [CTRL+O]

When you select Open, OPENBook opens a dialog box
called Select a File to Open. The dialog box contains a list
of available documents. Use the TAB key to move from field
to field, and the UP and DOWN ARROWS to move from item
to item within a field. When you locate the file you want to
open press ENTER.

Once you open a file, you must press a Speak key (KEYPAD
ENTER, F10, or F12) to have OPENBook begin reading to
you. Select "Open File Dialog Box" in the Help, Search for
Help on.

Close [CTRL+W]

When you select the Close option and have made changes
to the document, OPENBook will prompt you to save the
document



Save [CTRL+S]

Select this menu item to save the document you are
currently reading without closing it. When you select Save,
OPENBook automatically saves the document, and you can
continue reading. Some changes can only be saved in
OPENBooK's special format. When you select Save,
OPENBook will alert you to this and give you the option to
keep the OPENBook-specific changes in OPENBook's .ark
format, ignore those changes and save the document in
another format, or Cancel.

Save As

Select this menu item to save a copy of this document under
a new name or a different file format. The .ark file format
saves all changes that you have made to the document in
OPENBook, including text edits and bookmarks. The .txt
format saves only the actual text -- bookmarks will be
omitted. Other formats include Word, WordPro,
WordPerfect, and HTML. Select "Save As File Dialog Box"
in the Help, Search for Help on.

Save Pages [CTRL+SHIFT+S]

This command allows you to save either the current page or
a range of pages in the open document.

Often you will scan several pages of mail or other items, not
knowing whether you will want to keep them or not. You can
use the Save Pages function to selectively save only the
pages you need to keep. You can save just the page your
cursor is on, or you can specify a range of pages to save.

From the File Menu, choose Save Pages (ALT+F, then G).
OPENBook displays a dialog box and places your cursor on
a button named Save Current Page. If you want to save only



the current page, simply press the ENTER key. OPENBook
will take you to the File Open dialog and prompt you for a file
name.

If you want to save a range of pages, press the TAB key
once to go to the Page Selection edit box. Now enter the
range of pages you want to save, with a dash between them.
For example, if you want to saves pages 2 through 6, you
must enter 2-6 here. If you enter a number that is not in the
document, such as if you enter 2-6 in a 5-page document,
OPENBook will display and speak an error message. Once
you have entered a valid range, you press ENTER or press
the TAB key to go to the OK button, then press ENTER.
OPENBook will take you to the File Open dialog and prompt
you for a file name. You can cancel the operation at any
time by going to the Cancel button or pressing the ESC key.

Note: If you have used the Renumber Pages function to
change the number sequence in your document, you must
specify the revised page numbers in the Save Pages dialog.
There is a hotkey to save the current page. The hotkey is
CTRL+SHIFT+S. You can press CTRL+SHIFT+S from
anywhere in your document to save the current page, without
going into the Save Pages dialog box. Of course,
OPENBook will still prompt you for a file name.

Library

The Library calls the files Documents, and stores them in
Categories, which is a more familiar environment for some
OPENBook users that the Windows Files and Folders
approach. Press KEYPAD PAGE DOWN for more on the
Library.

Print [CTRL+P]



Select this menu item to print the document. When you
select Print, OPENBook opens the standard Windows Print
dialog box. The printed copy of your document will reflect
the text size, font, and spacing choices you have selected. If
you are using a color printer, your colored text will print in
color.

Printer Information edit fields

In this area you will be presented the following information:
Name of printer currently selected.
Status, such as ready or busy.
What kind of printer is selected.
Where the printer is and the printer port in use.
Comment field.

Print Options

Select from the following options:

All Pages

Range of Pages

Selected Text only

All Pages Plus Bookmarks
Number of Copies edit field
Enter the number of copies to print by typing or using the
arrow keys.

Press ENTER to start printing.

Print Setup

Select this menu item to determine how OPENBook sets up
the document for printing:



Paper Size

Paper Source
Margins Edits
Portrait or Landscape

Document Properties [CTRL+R]

Select this item to learn specific information about the open
document. When you select Document Properties,
OPENBook opens a dialog box listing various facts about the
document:

Document Name
Document type
MS-DOS name
Document location
Document size
Date created

Last modified

Last accessed.

These fields do not allow you to modify or add information.

List of recently read files (numbered 1
through 5)

This convenient Windows feature allows you to easily open
the files you last used. Either select the document and press
ENTER, or press the number and then ENTER to open the
file you want.



Exit

Select this menu item to close OPENBook. If you have
made changes to any open documents, OPENBook will ask
if you want to save the changes. You can also use ALT+F4.

Library

This feature allows users a different way to manage
documents and you can convert old OPENBook documents
for use with .OPENBook Finally, the Library also gives you
two additional menu functions: Delete and Convert.

When you select items from the Library Menu, OPENBook
presents you with a list of categories first. Once you choose
your category, OPENBook allows you to name the
document. You can also use items in the File menu to use
the same feature.

OPENBook has the following submenu options:

Read a Document

This option allows you to open a document for reading.
Create a New Document

This option allows you to create a new document, save it to a
library category, and then scan pages into it.

Close Document

This option allows you to close the document you are
currently reading. If you have made changes, you will be
prompted to save your document.

Save Document

This option allows you to save the document you are
currently reading without closing it.



Convert Document

This option allows you to convert an OPENBook document
to a word processing, ASCII, spreadsheet, or HTML format.

Delete a Document
This option allows you to delete a document.

Create a New Category

This option allows you to create and name new categories.
Be creative!

Delete a Category

This option allows you to remove categories that are
obsolete. However, you will not be able to delete a category
until you have deleted all documents inside that category.
OPENBook will ask you to verify your deletion.

Read a File

This option allows you to open and read a word processing,
ASCII, or spreadsheet file. Once you select Read a File, you
enter the standard Windows Select a File dialog box with a
list of available documents. Proceed as you would for the
Open feature.

Open File Dialog Box

File Name edit field

Type the name of the file you want. You do not usually need
to include the file extension, unless there is more than one
file with the same name but different extensions, or if the file
is in a different format from the format listed in the Files of
type field.



Files of Type list field

Use the arrow keys to select the file format for the file you
want. OPENBook will only list the files that match the file

type you select. Selecting the proper file format can make
your file search a lot quicker

Open button
Opens the selected document.

Cancel button
Closes the dialog box without opening a new document.

Up One Level button

Use this button to open the folder one level up from the
active folder. When you select Up One Level, OPENBook
will move to the folder one level up, and it will display the
contents of that folder in the file list. Note that you can also
move up one level by pressing the BACKSPACE key from
within the file list.

New Folder button

Use this button to create a new folder within the active folder.

When you select New Folder, OPENBook will place your
cursor in the file list, on the new folder name it has created.
Just type in the new name you want for this folder, and then
press ENTER. The folder will be named New Folder, until
you type in a new name for it.

Look in list field



Use this list to move among the drives and folders
(directories) on your computer. Use the UP and DOWN
ARROW keys to move through the drives and folders, and
then press the ENTER key when you find the folder you
want. The contents of the folder will then appear in the file
list below. You can use ALT+UP ARROW and ALT+DOWN
ARROW to display the folder list while moving through it.
Use HOME and END to move to the first or last item in the
drive and folder list. You can also use the SPACEBAR to
jump directly from drive to drive.

File list field

Use this field to display the files and folders in the drive or
folder that you selected in the Look in box. To move up and
down the list of available documents, use the arrow keys.
Press ENTER to select the file you want. You can also type
the first letter or character of the file you want. OPENBook
will go to the first file in the list that starts with that character.
When you type that character again, OPENBook will take
you to the second file in the list that starts with the character.
After repeated presses of that key, OPENBook will
eventually cycle back to the first file. If the folder is empty,
OPENBook will say "No entries.

Note: If you create files using a word processing program or
other application, those files will be saved in the appropriate
location for that application. This will probably not be the
same place that your OPENBook documents are stored.
Use the Look in field to go to the folder that contains your
other documents. After you open a file, you can save it to
your OPENBook Library or any other location.



Save As Dialog Box

File Name edit field

Type the name you want to use to save this file. You do not
usually need to include the file extension, unless there is
more than one file with the same name but different
extensions, or if the file is in a different format from the
format listed in the Files of type field.

Files of Type list field

Use the arrow keys to select the file format for the file you
want to save. OPENBook will only list the files that match
the file type you select.

Save button
Saves the file using the name you selected.

Cancel button
Closes the dialog box without saving the document.

Up One Level button

Use this button to open the folder one level up from the
active folder. When you select Up One Level, OPENBook
will move to the folder one level up, and it will display the
contents of that folder in the file list. Note that you can also
move up one level by pressing the BACKSPACE key from
within the file list.

New Folder button



Use this button to create a new folder within the active folder.
When you select New Folder, OPENBook will place your
cursor in the file list, on the new folder name it has created.
Just type in the new name you want for this folder, and then
press ENTER. The folder will be named New Folder, until
you type in a new name for it.

Look in list field

Use this list to move among the drives and folders
(directories) on your computer. Use the Up and Down arrow
keys to move through the drives and folders, then press the
ENTER key when you find the folder you want. The contents
of the folder will then appear in the file list below. You can
use ALT+UP ARROW and ALT+DOWN ARROW to display
the folder list while moving through it. Use HOME and END
to move to the first or last item in the drive and folder list.
You can also use the SPACEBAR to jump directly from drive
to drive.

File list field

Use this field to display the files and folders in the drive or
folder that you selected in the Look in box. To move up and
down the list of available documents, use the arrow keys.
Press ENTER to select the file you want. You can also type
the first letter or character of the file you want. OPENBook
will go to the first file in the list that starts with that character.
When you type that character again, OPENBook will take
you to the second file in the list that starts with the character.
After repeated presses of that key, OPENBook will
eventually cycle back to the first file. If the folder is empty,
OPENBook will say "No entries.



Tips and Techniques When Working
with Files and Folders

If you have a large document, several hundred pages, you
may want to save it into smaller, separate chunks. This will
help when you are editing or saving the document.

For example, if you have chosen to save the Exact Page
representation of your documents, these files will take up
much more space on the disk than simple text files. There
are several ways to reduce the size of a large file:

» Save the document as a .txt file -- this will delete the
scanned pages (the Exact View option), leaving only the
Text View

= |If you know in advance that you want to save scanned
pages to a floppy disk, be sure to divide the project into
smaller groups of pages (1-10 pages per file).

= Scan and save one group into a file, close it, and start a
new one for the next group.

Why is some formatting lost when | view my word
processor file in OPENBook?

When OPENBook converts a word processing file into a
OPENBOooK file, it gives you a great deal of control over the
size, color and spacing of the text, letting you display the text
in a way that is easiest to read. However, to give you that
control, when a file is imported into OPENBooKk, the



formatting information from the original file, such as bold,
italics, underline, and font, is retained but hidden. When you
next save the file, the formatting is saved along with it
(unless you save to a .txt format). When you save a file in its
original format, most format attributes will be restored and
visible on screen. If formatting a file for output is critical, you
should use a word processing program.

View Menu [ALT+V]

The View Menu lists options that you can use if you are
using a monitor. This menu allows you to choose which
OPENBook screen elements are visible, in which format
pages are displayed, and determine the scrolling and zoom
options.

Show Exact View/Show Text View
[CTRL+SHIFT+V]

Select Show Exact View to display the scanned page on the
screen just as it is in the original document, including any
graphics, line art, tables, columns and other elements that
affect how the page looks. While in Exact View, you can
read the page, change text and background colors, zoom in
and out, and use the dictionary and spelling functions.

However, you cannot edit or make any other modifications to
the way OPENBooOkK presents the text. To make
modifications, you must switch to Text View.



You cannot select Exact View if you are reading a text, word
processing, or other electronic document: this item is only
available for scanned pages.

Note: When you open a previously scanned document, it will
automatically open in Text View. Change to Exact View
using this menu item.

Select Show Text View to display only the text from the
page, without graphics, line art, tables, columns, and other
elements that affect how the page looks.

While in Text View, you can edit the document and modify
the way OPENBook presents text on the screen. When
opening a document, OPENBook automatically selects this
View.

Note: The Exact View is only available if you have selected
"Save Exact View" in the Scanning Settings page of the
Settings menu.

Status Bar [SHIFT+F5]

Select this menu item to display or hide the status bar (the
line at the bottom of the screen). When the cursor is on a
menu item, the status bar displays a brief description of that
item. To have that information spoken, press SHIFT+F1. A
check mark indicates the item is selected.

Zoom Page



You can change the display of the scanned page shown in
Exact View by selecting one of the ranges displayed on the
ZOOM Submenu. The list of zoom ranges from 25% of
normal size to 500% of normal size. To check or uncheck a
zoom range, move to the number on the menu, then press
ENTER.

Page Scrolling

Open this menu item to select how much of the page is
moved up when OPENBook is reading and gets to the
bottom of the page:

One line
1/2 screen
3/4 screen

Tips on using OPENBook to Read

The most efficient way to scan and read a book is to use
Large Batch as the Scanning Mode. This option is located
on the Scanning Settings properties page, in the Scanning
menu. With Large Batch, you scan all the pages, and then
go do something else while OPENBooK is recognizing the
pages. Later, when recognition is complete, you can read
the book.

If you are reading a paperback or other book in which both
facing pages fit on the scanner, then you should use 2-page
scanning.



| scanned a book in batch mode and the pages are in
reverse order. Why?

You probably scanned the book from back to the front.

How do | read my phone bill?

Read your phone bill just as you would any other document.
Be sure to use Most Accurate Recognition. Because of the
complex layout of some bills, it also might help if you turn off
Recognize Columns. Finally, you might also try changing
Text Type field to "Typewritten or Dot Matrix Text" rather
than "Normal Text." You can find this field on the Scanning
Settings properties page in the Scanning menu.

What type of documents can't | read with OPENBook?

OPENBook can scan -- take a picture of -- any page.
However, it can only convert and read aloud text that is
printed or typewritten. OPENBook cannot convert and read
handwritten or hand-printed material. If there is a signature
on a typewritten letter, OPENBook can read the letter aloud
but not the signature. If the signature is written over other
printed words, for example, the closing "Sincerely yours,"
OPENBook will not read the letters touched by the signature
correctly.

OPENBook may have trouble reading some printed forms
because the text on a form is often surrounded by a box.
OPENBook sometimes ignores text that is too close to
vertical or horizontal lines or surrounded by a box.

You'll probably have difficulty using OPENBook to read box
scores on the sporting page or the stock market pages in the
newspaper. Even if OPENBook reads most of the text
correctly, it may be hard to determine the meaning.



Can | use OPENBook to read without speech output?

Yes. Simply uncheck the Speech On item on the Settings
menu.

Editing

You can edit and save a word processing or other computer
file. You can also edit and save a scanned document. Let's
try it with one of the sample documents Arkenstone installed
with the software.

= First, using the Library, go to the General category and
open Caesar.ark.

= Again using the Library, save that document in the
General category, under a new name: Editing.

Right now, you are in Read-only Mode. This means that you
can read the document, but cannot make edits. This
protects you from accidentally making changes to a
document.

Hold down ALT and press the E key. OPENBook will open
the Edit Menu at the item, Edit Mode.

Press Select to activate Edit Mode and OPENBook's editing
capabilities.

A few general notes about editing:

Insert versus Overtype



If you've used other PC programs, you know that most
programs start in "insert" mode, that is, if you start typing, the
software inserts what you are typing, but does not "write
over" any other text that may already be on the screen.
Some software programs allow you to switch to "overtype"
mode. In this mode, when you type, you actually write over
other text, eliminating it.

OPENBook is always in insert mode -- you will never
accidentally type over other text. The only place where your
typing may replace text that's on the screen is in a dialog
box. A dialog box has buttons and fields that help you
perform certain OPENBook functions. In some parts of a
dialog box, OPENBook may offer a suggestion, for example
a name. If you wish to change this suggested item, simply
type a name of your choosing. Your typing will replace the
name OPENBook suggested.

Selecting Text

In addition to typing, the other skill you will need to use while
editing is called "highlighting" or "selecting text." Selecting
text allows you to specify which text will be affected by an
editing operation, for example Copying or Deleting.

To select text using the keyboard, find the word you want at
the beginning of your selection. Next, hold down the SHIFT
key, and use the Move keys to move through the text until
you reach the final text you want to select. If you use the
SHIFT key plus the ARROW KEYS, you will select a
character at a time. If you add the CTRL key to the SHIFT
and arrow keys, you will select a word at a time.

To select text using the mouse, place the mouse cursor over
the word you want at the beginning of your selection. Click



and hold down the left mouse button. Drag the mouse
through the text, word by word, or line-by-line, until you reach
the final word you want to select. Let go of the mouse. As
you select it, the text on the screen will be highlighted.

Note: Don't use the mouse anywhere else on the screen or
you will deselect the highlighted text.

Note: Do not begin typing while text is selected. The text
you type will replace the selected text.

The Windows Clipboard

When using the edit feature, you will also be using the
Windows clipboard. The clipboard is a special area in the
computer that "holds" text for you. You can cut text, and
place it into the clipboard, then move through the document
to find a new location for the text. Once there, you can paste
the text from the clipboard into the new location.

The clipboard will hold a piece of text in it until you copy new
text to the clipboard, or until you turn off your computer.

Edit Menu [ALT+E]

This menu allows you to edit a document, find text, add a
bookmark, jump to a specific page, or move pages around in
your document. Using the edit feature, you can type new
text into a document; move, copy or delete text; introduce or
delete page breaks; and move pages of text around within
the document.

Edit Mode/Read-only Mode [CTRL+E]



To switch between Edit Mode and Read-only Mode, use this
item. When you start OPENBook, you are in Read-only
Mode. To switch to Edit Mode, move to the item on the
menu, then press ENTER. Or, select the item by using the
menu shortcut key. Once you check the item, OPENBook
will tell you whether you are in Edit Mode or Read-only
Mode.

Undo [CTRL+Z]

Undo allows you to remove the effect of the last edit you
performed, whether it was typing or deleting. Note that Undo
only undoes the last change you have made.

Cut [CTRL+X]

Select this menu item to remove selected text from the
document and copy it to the Microsoft Windows clipboard.
You can only use this item if you have already selected text
using the SHIFT key with the ARROW keys, or if you have
used a mouse to drag-select some text. Once you have
selected the text, select Cut, and OPENBook deletes the text
from the document and copies it to the clipboard. You can
then paste the text into another part of the open document,
into a new OPENBook document, or into another application
such as Microsoft Word. This item is only available when
you are in Edit Mode and text is selected.

To Cut and Paste Text

Select and highlight the first line of text in your document.
Now press CTRL+X to cut the text. The selected text is
removed from the page and put in the Windows clipboard.

Using the move keys, find a new location for the text. Press
CTRL+V to paste the text. The text that you cut to the
clipboard will be inserted at the new location you selected.



Copy [CTRL+C]

Select this menu item to copy selected text to the Microsoft
Windows clipboard without removing it from the document.
You can only use this item if you have already selected text
using the arrow keys or mouse. Once you have selected the
text, select Copy, and OPENBook copies the text to the
clipboard. You can then paste the text into another part of
the open document, into a new OPENBook document, or
into another application such as Microsoft Word.

To Copy and Paste Text

Select and highlight another line of text in your document.
Press CTRL+C to copy the text. The selected text remains
on the page, but is also copied to the Windows clipboard.

Using the move keys, find a new location for the text. Press
CTRL+V to paste the text. The text will be inserted at the
new location.

Paste [CTRL+V]

Select this menu item to insert text from the Microsoft
Windows clipboard into your document. You can only use
this item if you have already copied selected text into the
Clipboard. You can paste the text into another part of the
open document or into a new OPENBook document. (Or
you can paste text into another application such as Microsoft
Word, by using the hotkeys or using that application's Paste
function.) Find the location where you want the text inserted,
then select Paste. The text is inserted into the document.
This item is only available when you are in Edit Mode and
there is already text in the Clipboard.

Delete [DEL]



Select this menu item to delete selected text from the
document without copying it to the Microsoft Windows
clipboard. Once you have selected the text, select Delete,
and OPENBook deletes the text from the document. This
item is only available when you are in Edit Mode.

Note: The selected text is deleted from the page
permanently. When you use Delete, the text is not copied to
the Windows clipboard; it's just gone.

Select All on Current Page [CTRL+A]

Select this menu item to select (or "highlight") all the text in
the document. Once you have selected all the text, you can
Cut, Copy, or Delete it. Although this item is available in
both Read-only and Edit Mode, you can only Cut, Delete,
and Paste the selected text when you are in Edit Mode.

Find [CTRL+F]

Select this menu item to find a word or phrase within the
open document. When you select Find, OPENBook opens
the Find dialog box.

Here's how the Find feature works. First you should open
the document in the OPENBook directory called Caesar.ark.
Once you have that file open, use the ARROW keys to move
to the top of the page.

Open the Edit menu and move to the item called Find. Press
ENTER. OPENBook will open the Find dialog box, and say
"Find What?"

Type in the word "ransom."

Using the TAB key on the keyboard, TAB twice to the Find
Next button, then press ENTER. OPENBook starts
searching for the word you have typed. If it finds it,



OPENBook goes to that word in the document, and places
the cursor at that point. If OPENBook doesn't find the word,
it notifies you.

Select the Read Sentence button to read the sentence in
your document that contains the word you entered. |If
OPENBook does not find sentence-ending punctuation in the
current line or the line before or after the word, it will read
only the current line.

When you are done, TAB to the Cancel button, then press
ENTER. This closes the Find dialog box.

Other available options are:
Find whole words only

Check this item to have OPENBook search for occurrences
that are whole words and not part of a larger word. The
default setting for this item is unchecked.

Match case

Check this item to have OPENBook distinguish between
uppercase and lowercase letters during the next search.
When Match Case is selected, OPENBook only finds words
in which the capitalization matches that of the text you typed
in the Find What field. The default setting for this item is
unchecked.

Search Direction list field

To move between Up and Down, type "U" or "D" or the press
the arrow keys. Select Down if you wish to search forward
from your current point in the file. When it reaches the end
of the file, the Find feature will wrap around to the beginning
of the file and search from there to your cursor. Select Up if
you wish to search back from your current point in the file
toward the beginning of the file. When it reaches the top, it
will search from the end to your cursor. Either way, it will
search the entire document.



Read Sentence button.

Reads the sentence in your document that contains the word
you entered. If OPENBook does not find sentence-ending
punctuation in the current line or the line before or after the
word, it will read only the current line.

Find, Replace Text [CTRL+H]

Select this menu item to find a word or phrase within the
open document, and replace it with alternative text.

Go To Page [CTRL+G]

Select this menu item to go to a specific page in the open
document. When you select Go To, OPENBook opens the
Go To Page dialog box.

Go To Page dialog box

Enter the Page Number edit field

Type in the number of the page you wish to go to.
OK button

Takes you to the top of the page whose number you have
specified.

Cancel button

Closes the dialog box without moving your cursor.



If the document does not contain the requested page,
OPENBook will take you to the nearest page, which will be
the first or last page in the document.

Renumber Pages

This command allows you to change the numbering system
for the pages of the open document.

When you scan a document that does not begin on page 1,
such as part of a book, you will sometimes want to maintain
the book's page numbers in your scanned document. This
function allows you to do that.

From the Edit Menu, select Renumber Pages (ALT+E, then
A). OPENBook will bring up a dialog box and place your
cursor in an edit box so that you can enter a new page
number. OPENBook always prompts you with the current
page number, and asks you what new number you want to
assign to that page. Type in a number, then press ENTER,
or TAB to the OK key. You can cancel the operation at any
time by going to the Cancel button or pressing the ESC key.

You can renumber pages many times. You can give each
succeeding page a new number. But each page number
must be larger than the page numbers before it. Page
numbering can only go up. For example, you could have a
3-page document that you renumber as pages 10, 20, and
30, but you can't renumber the pages as 20, 30, and 10,
because the numbers are not all going up. If you type in a
number that breaks this rule, OPENBook will prompt you to
enter a valid number.

You can revert back to OPENBooK's original page
numbering sequence at any time by Tabbing to the checkbox
called Revert to original page numbers. Press the
SPACEBAR to put a check in this box, then press ENTER.
The page numbers will now begin at page 1.



Insert Bookmark [CTRL+F9]

Select this menu item to insert a bookmark symbol in the
document text. Each bookmark is numbered and is linked to
the word to its right. You can use bookmarks as
placeholders. You can jump from bookmark to bookmark.
You can also print your file including bookmarks. When you
select Insert Bookmark, OPENBook inserts a numbered
bookmark at the current cursor position in the open
document. You can insert as many bookmarks as you want
in each document.

Delete Bookmark [SHIFT+CTRL+F9]

Select this menu item to delete a selected bookmark symbol
in the document text. You can only use this item if you have
already selected text using the arrow keys or mouse. Once
you have selected the text, select Delete Bookmark, and
OPENBook deletes the bookmark from the document. You
can also delete a bookmark by placing your cursor
immediately after the bookmark character and pressing the
BACKSPACE key.

Go To Bookmark [F9]

Select this menu item to jump to a bookmarked word in the
open document. When you select Go To Bookmark,
OPENBook Open s the Go To Bookmark dialog box. If the
open document does not contain bookmarks, this item will
not be available. See "Go To Bookmark dialog box" in Help,
Search for Help on.

Enter a Bookmark Number edit field
Type in the number of the bookmark you wish to find.



Next Bookmark button

Takes you to the next bookmark in the document.
Previous Bookmark button

Takes you to the previous bookmark in the document.
First Bookmark button

Takes you to the first bookmark in the document.
Last Bookmark button

Takes you to the last bookmark in the document.

Go button

Takes you to the bookmark whose number you have typed
into the Edit Field.

Close button
Button closes the dialog box.

If the document does not contain the requested bookmark,
OPENBook will beep, and the cursor will remain where it is.

Delete Exact View

Use this command to delete the Exact View for all pages in
the open document.

Exact View is OPENBook's display of a scanned page
exactly as it appears in the original document, including
graphics, pictures, tables, columns, and other elements. In
addition to the obvious visual benefits of Exact View,
OPENBook also uses Exact View for its new Page Layout
functions. Therefore, you may prefer to scan many
documents retaining the Exact View, even if you are not
going to be using them visually. However, the Exact View
makes your files bigger, so to save hard disk space, you can



delete the Exact View from the file after you are done using
it.

From the Edit Menu, select Delete Exact View (ALT+E, then
X). OPENBook will ask you to confirm the deletion. Note

that this command deletes the Exact View from all pages in
the open document, not just the current page.

Insert Page Break [CTRL+ENTER]

Select this menu item to insert a page break in the
document. If you select Insert Page Break while you are
reading a scanned file, OPENBook warns you that you will
lose any images associated with the pages. This means that
your Text View (the one you are editing) will no longer match
your Exact View. OPENBook then inserts a page break
immediately before the current line of the document. The
text after the inserted page break becomes the beginning of
the new page; the text before the inserted page break
becomes the end of the previous page. This item is only
available when you are in Edit Mode and are working with a
Scanned document,

Move Page

Select this menu item to move the current page to another
location in a document. When you select Move Page,
OPENBook Open s the Move Page dialog box. If the open
document does not contain more than one page, this item is
not available.

Move Up One Page button

Moves the current page forward one page in the document.
Move Down One Page button

Moves the current page back one page in the document.
Move to Top button



Moves the current page to the beginning of the document.
Move to Bottom button

Moves the current page to the end of the document.
Move to Page edit field

Type in the page number to which you wish to move the
current page. Or type in the relative position you want to
move to. For example, if you are on page 50 and you know
you want to move the page to page 48, you can enter -2 to
move back 2 pages. Or enter +10 to move the page forward
10 pages in the document.

OK button

Moves the current page to the page number you have typed
into the Edit Field.

Cancel button
Closes the Move Page dialog box.

Once OPENBook moves the page, it will tell you the current
page's new page number. Please note that all other pages
in the document will be renumbered as necessary to
accommodate the moved page.

Delete Current Page [CTRL+DELETE]

Select this menu item to delete the page your cursor is on.
When you select Delete Current Page, OPENBook Open s a
small dialog box on the screen warning you that page
deletion cannot be undone, and asking you to confirm the
deletion.

OK button
Deletes the page and closes the Delete dialog box.



Cancel button
Closes the Delete dialog box without deleting the page.

Tools Menu [ALT+T]

This menu gives you access to a variety of tools including a
spell checker and reference materials.

Spell Check [CTRL+K]

Select this item to Open the spell checker. You can check
the spelling of a specific word, or of all the words in the
document. OPENBook checks words against a standard
dictionary and against your "personal dictionary," a list of
words that you can enter.

However, OPENBook may encounter words that are not in
the dictionary, especially formal names and other proper
nouns. When OPENBook encounters a word like this, the
word will be identified as "misspelled.”" You can easily
ignore these words, and continue searching for the ones you
need to correct.

Spell Check dialog box

Read Sentence Button

Select the Read Sentence button to read the sentence in
your document that contains the word you entered. If



OPENBook does not find sentence-ending punctuation in the
current line or the line before or after the word, it will read
only the current line.

If you TAB once, you'll hear that OPENBook suggests you
replace "Agnes" with "Agent." Instead, TAB again to the
Ignore button and press ENTER. OPENBook will ignore this
instance of Agnes and look for the next misspelled word.
However, this will also be "Agnes."

Note: To avoid being informed about every instance of the
unrecognized word "Agnes," TAB three times, to the Ignore
All button, and press ENTER. Now, OPENBook will ignore
"Agnes" every time it's found.

The next word OPENBook will find is Nickerson's -- another
proper name. TAB to Ignore.

Now OPENBook finds "Grey." Why is this considered
misspelled? Use the Move Left arrow key to move back
through and listen to this word. You'll hear that it's spelled
with an "e." This spelling may be correct in some English-
speaking countries, but our dictionary doesn't accept it. TAB
once to Replace With and you'll see why. OPENBook
suggests "gray," spelled with an "a." This is the preferred
spelling in the United States.

TAB three times to the Change button, and press ENTER.
OPENBOooKk tells you that it made the replacement. Then it
goes on to find the next misspelled word.

When done, TAB until you reach the Close button, then
press Select. This closes the Spell Check dialog box.

When you select Spelling, OPENBook Open s the Spelling
dialog box. The first word identified by the dictionary as
misspelled is spoken when the dialog box Opens.

Other options include:
Change All button



Changes all occurrences of the misspelled word to the word
suggested in the Replace field.

Add to Dictionary button

Adds the word to your own list of frequently used words not
found in the standard dictionary.

Spell Word [CTRL+L, CTRL+F3]

Select this menu item to spell the word the cursor is on.
When you select Spell, OPENBook speaks the selected
word aloud, spells it letter by letter, and then speaks it aloud
again. If you do not have a word selected to spell,
OPENBook notifies you.

Spell Word Phonetically [SHIFT+F3]

Select this menu item to spell the word the cursor is on
phonetically, using military spelling. When you select this
item, OPENBook spells the selected word using names,
such as Alpha, Bravo, and Charlie, for the letters (in this
case A, Band C).

Word Count [SHIFT+F7, SHIFT+CTRL+3]

Select this menu item to count the words in your current
document. When you select Word Count, OPENBook Open
s a dialog box that tells you the number of words in the
document.

Dictionary [CTRL+D, F8]

Select this menu item to open the dictionary. You can look
up the meaning of a word by selecting the word, then



selecting Dictionary. When you select Dictionary,
OPENBook Open s the Dictionary dialog box, announces the
selected word to be defined, and begins reading the
definition.

Definition field

Gives the definition of the selected word. To read through at
your own pace, use the arrow keys. You cannot modify this
field.

Show Expanded Definition check box

Tells you whether this box is checked. When this box is
checked, OPENBook gives you the most comprehensive
definition, including supplemental or related words. When
unchecked, OPENBook gives you the basic definition of the
word.

Switch to Thesaurus button
Shifts you into the thesaurus feature.
Read Sentence.

Reads the sentence in your document that contains the word
you entered. If OPENBook does not find sentence-ending
punctuation in the current line or the line before or after the
word, it will read only the current line.

Close button
Closes the dialog box.
Selected Word edit field

Indicates the selected word. You can also type a word to be
defined into this field, and then press ENTER. OPENBook
will give the definition of the new word in the "Definition"
field.



Thesaurus [CTRL+T, SHIFT+F8]

Select this item to open the thesaurus. You can look up a
word's synonym by selecting the word, then selecting
Thesaurus. When you select Thesaurus, OPENBook opens
the Thesaurus dialog box. OPENBook gives a list of
synonyms in the large Edit Field below "Synonyms."

When you select Thesaurus, OPENBook opens the
Thesaurus dialog box, announces the selected word, and
begins reading a list of synonyms.

Synonyms field

Lists synonyms for the selected word. To read through at
your own pace, use the arrow keys. You cannot modify this
field.

Switch to Dictionary button
Shifts you into the dictionary feature.
Read Sentence.

Reads the sentence in your document that contains the word
you entered. If OPENBook does not find sentence-ending
punctuation in the current line or the line before or after the
word, it will read only the current line.

Close button
Closes the dialog box.
Selected Word edit field

Indicates the selected word. You can also type a word into
this field, and then press ENTER. OPENBook will list the
synonyms of the new word in the "Synonyms" field.

Key Settings [F11]

Select this menu item to change the keypad key
assignments. To give you greater flexibility, users of screen



access programs such as JAWS and other screen reader
programs can reprogram the keypad keys to conform to the
screen access key assignments.

When you start OPENBook, this menu item is set to use
OPENBook key settings. To select the alternate key settings
you designated in the KEYS.INI file, open the menu and
move to Key Settings. OPENBook will announce the change
in your settings. To return to the OPENBooOkK settings, once
again open the Tools menu and move to Key Settings. Note:
frequent users may find using the F11 key a more
convenient way to cycle between the key settings options.

Pronunciation Dictionary

Use the Pronunciation Dictionary to change the
pronunciation of any word or combination of letters.

Most speech synthesizers do a very good job of pronouncing
words through a combination of their text-to-speech
programming and their internal dictionaries. However, there
will always be words or letter combinations that a given
synthesizer will not pronounce well. These words vary from
synthesizer to synthesizer. Using OPENBooOK's
Pronunciation Dictionary, you can change the pronunciation
of any text string.

From the Tools menu, select Pronunciation Dictionary
(ALT+T, then N). OPENBook will bring up the Pronunciation
Dictionary dialog box and will place your cursor in the field
where you can enter the word your synthesizer is
mispronouncing.

The tab order of the items is:
° Word



Pronunciation
Case Sensitive
Test

Add

Delete

Close

Word List

Word (ALT+W)

This is the field in which you enter the mispronounced
word. OPENBook only looks for whole words. It will
ignore any spaces you try to enter. It also ignores
punctuation, so it will pronounce "it's" and "its" the same
way.

Pronunciation (ALT+P)

This is the field in which you enter the correct
pronunciation for the word. Pronunciations can include
spaces. Sometimes inserting a space between letters
helps with placing the stress on the correct syllable, and
with pronunciation of vowels.

Case Sensitive (ALT+E)

Check this field if you want OPENBook to perform a case-
sensitive pronunciation replacement. To check the box,
TAB to it, then press the SPACEBAR. For example, you
might want OPENBook to pronounce the text string "pa"
as the word "pa" when the letters are not capitalized, but
to say the individual letters, "P" "A", when they are
capitalized. You would type the upper-case letters "PA" in
the Word field, type the letters "P" and "A" (upper- or
lower-case) in the Pronunciation field, and check the Case



Sensitive box. The default for this setting is unchecked,
that is, not case sensitive.

Test (ALT+T)

Select this button to hear the original word and the
replacement pronunciation. You can use the Test button
to test a word's pronunciation before you add it to the list.
You can also use the Test button to check the
pronunciation of a word in the word list. Just arrow
through the word list, and enter ALT+T when you want to
hear a word and its pronunciation.

Add (ALT+A)

Select this button to add a word and its pronunciation to
the word list. OPENBook will let you know that it has
added the word.

Delete (ALT+D)

Select this button to delete a word and its pronunciation
from the word list. OPENBook will not ask you to confirm
the deletion, but it will let you know that it has deleted the
word.

Close (ALT+C)

Select this button to close the Pronunciation Dictionary
dialog and return to your document.

Word List (ALT+L)

This is the list of words in the pronunciation dictionary.
When you TAB to this item, OPENBook says "no
selection" because you have not yet moved your arrow
keys to a word in the list. Press the DOWN ARROW key
to advance to the first word in the list. You can hear the
mispronounced word and its correct pronunciation at any
time by pressing ALT+T for Test.



OCR Correction

Use the OCR Correction dialog box to correct any words that
OPENBook's OCR engine has not correctly identified.

OPENBook's OCR engines usually do a very good job of
identifying text correctly. However, due to the wide range of
type styles, fonts, and reproduction quality for documents
you are likely to encounter, not all words will be correctly
identified with every scan. Using OPENBook's OCR
Correction feature, you can apply corrections for any text
string to your documents.

From the Tools menu, select OCR Correction (ALT+T, then
0O). OPENBook will bring up the OCR Corrections dialog box
and will place your cursor in the field where you can enter
the word that has been incorrectly identified. There are
several other items in this dialog box. We will list each item
in the order you would TAB to it, and then we will describe
each item briefly.

The tab order of the items is:

o Mis-identified Word

. Correct Word

o Case Sensitive

o Test

e  Apply to Current Document

o Add

) Delete

. Close

e Word List

Mis-identified Word (ALT+M)



This is the field in which you enter the word that
OPENBook has not recognized correctly. OPENBooK's
OCR Correction feature only looks for whole words. It will
ignore any spaces you try to enter. It will recognize
punctuation. In fact, punctuation characters are some of
the most common mis-identified ones.

Correct Word (ALT+R)

This is the field in which you enter the word the way
OPENBook should have recognized it. Corrections can
include spaces.

Case Sensitive (ALT+E)

Check this field if you want OPENBook to perform a case-
sensitive OCR correction replacement. To check the box,
TAB to it, then press the SPACEBAR. The default for this
setting is unchecked, that is, not case sensitive.

Test (ALT+T)

Select this button to hear the original word and the
replacement word. You can use the Test button to test a
word and its correction before you add it to the list. You
can also use the Test button to check words already in the
word list. Just arrow through the word list, and enter
ALT+T when you want to hear a word and its correction.

Apply to Current Document (ALT+P)

Select this button to have OPENBook apply corrections
from its list to the open document.
Add (ALT+A)

Select this button to add a word and its correction to the
word list. OPENBook will let you know that it has added
the word.

Delete (ALT+D)



Select this button to delete a word and its correction from
the word list. OPENBook will not ask you to confirm the
deletion, but it will let you know that it has deleted the
word.

Close (ALT+C)

Select this button to close the OCR Correction dialog and
return to your document.

Word List (ALT+L)

This is the list of words in the OCR correction table.

When you TAB to this item, OPENBook says "no
selection" because you have not yet moved your arrow
keys to a word in the list. Press the Down Arrow key to
advance to the first word in the list. You can hear the mis-
identified word and its correction at any time by pressing
ALT+T for Test.

Email

OPENBook version 5.0 includes an email program.
OPENBook's email program includes all the standard email
features, such as an Inbox, ability to read, write, reply to, and
forward messages, an address book, send and receive file
attachments, and the ability to create folders to store
messages in.

What Is Email?



Email, or electronic mail, is a way to send and receive
messages through your computer. You can send messages
to anyone who is connected to the Internet. You can also
send pictures and other files by attaching them to your email
messages. Millions of people send and receive email every
day.

Email messages typically include the same thing letters or
memos do: addressing information plus the message itself.
They start with the name and address of the person you are
sending the message to. This is usually followed by your
address, the names of any other recipients of the message,
the date, and the subject of the message. The recipients'
addresses must be typed following very strict rules. If you
miss a single letter, or get the syntax wrong, your message
won't get to the intended recipient. All this addressing
information, called the "header," is at the top of the screen.
The body of the message is below the header.

To use email, your computer needs to have a connection to
the Internet. The most common methods to make this
connection are a modem, a digital subscriber line (DSL), or a
local area network (LAN). These are the actual hardware
connections to your computer. Computers in homes usually
use a modem or DSL, and computers at the workplace
usually use a LAN.

You also have to have an email program, often called an
email client. OPENBook's email system is email client
software that has been designed specifically for use by
people with visual impairments.

Finally, you will need an account with an Internet service
provider (ISP). An ISP is a company that handles sending
and receiving the email messages, among other things.
When you have an ISP, you will usually also have access to



the World Wide Web, commonly known as "the Web." Some
ISP accounts are free, and some charge a monthly fee.

A popular way to connect to the Internet is through an online
service provider. Examples of online services are
CompuServe, America Online, and Yahoo. These online
services are different from ISPs in that they provide their own
unique content and special services available only to their
subscribers. They usually provide Internet and Web access,
plus email accounts.

How Does OPENBook's Email Work?

Before you can use OPENBook's email system, you need to
have a modem, DSL, or LAN to connect with the Internet.
You also need to have an account with an ISP or an online
service. OPENBook's email system will communicate with
your modem to dial up the connection you have specified.

You need to set up OPENBook's email system by giving it
information about your Internet connection, such as your
user name, address, and password. You also need to
specify the incoming and outgoing routing addresses for your
email messages. You will need to enter that information in
the Email Settings page, which is in the Settings menu. The
next section discusses the items in the Email Settings page.

Email Settings

You must tell OPENBook what settings your computer uses
to connect to the Internet. You do that by completing the
blanks in the Email Settings page. To get to the Email
Settings page, go to the Settings menu item (ALT+G), then



select Email Settings using the arrow keys or by pressing the
E key. The rest of this section covers the Email Settings in
the order they appear. If the Email Settings information is
complete, you can sKkip this section and go to the next
section, called "How to Start Email."

The first three items identify how your computer sends
outgoing email. Email is usually sent using a protocol called
SMTP. To send email, OPENBook needs to know your
name, your email address, and the address of the SMTP
server your computer uses.

The next four items identify how your computer receives
incoming email. Email is usually received using a protocol
called POP3. To receive email, OPENBook needs to know
your user login name, your password, and the address of the
POP3 server your computer uses.

If your computer is connected to the Internet using a local
area network (LAN), you should check with your Network
Administrator for these settings. If your computer connects
to the Internet using a modem or DSL line, you can probably
find the information OPENBook needs in the Control Panel
or in your ISP's (Internet Service Provider's) Properties menu
item.

Note: You must save the settings if you want this information
to be available the next time that you run OPENBook. If you
want these settings to come up automatically when you run,
OPENBook you must save the user settings using Default as
the settings name. This will overwrite the Default settings
with your modifications.

Sending Mail
Name (ALT+N)



You must tell OPENBook what name is listed for this
connection. This name will appear whenever you send an
email. It will be your "formal name." Usually this will be your
first and last name.

Email Address (ALT+E)

Enter your complete email address. This address will follow
a standard format: your user name followed by the @ (at)
sign followed by the name of the Internet service you use. It
will look something like this:

yourname@mindspring.com.

Note that we are referring here to your user name, not your
formal name. Although they could be the same, they are
usually different: the user name is often a shortened version
of your formal name. Thus, your formal name could be
"Jane Doe" while your user name could be "jdoe" or many
other possibilities. Sometimes your ISP (Internet Service
Provider) chooses your user name, and sometimes you get
to select one yourself.

SMTP Server (ALT+S)
The SMTP Server is the outgoing mail server address. It will
probably look something like this:

smtp.mindspring.com,

although some servers use "mail" instead of "smtp" in the
address.

Settings for Receiving Email
User Login Name (ALT+U)



This is your email name without the ending part. For
example, if your email address is
yourname@mindspring.com, then your user login name is
yourname. This information is in the Servers page in Mail
and Fax Properties, in a field called Account Name.

Password (ALT+P)

Every Internet account has a password to protect your
privacy. Passwords are usually five to eight characters long.
OPENBooK, like most programs, represents each character
visually by an asterisk. In addition, OPENBook does not
speak the characters as you type them or review them.
These things are done so that other people cannot learn
your password.

Save Password (ALT+V)

You can check this box to tell OPENBook to save and
remember your password so that you don't have to enter it
every time you log on. Your password is saved in an
encrypted format so you don't have to worry about others
finding out your password.

The default setting (the setting when you first start
OPENBooKk) for this item is unchecked.

POP3 Server (ALT+3)

The POP3 Server is the incoming mail server address. It will
probably look something like this: pop3.mindspring.com,
although some servers use "mail" or other text instead of
"pop3" in the address.

Time displayed as 24 hour (ALT+T)



OPENBooKk lists the time each mail message is sent or
received. You can have the time displayed in either 12-hour
or 24-hour format. The default is to use 12-hour format.

Leave mail on server (ALT+L)

If OPENBoOK is not the only email system you use, you may
want to leave your incoming email messages on the server.
To do this, check this box. The default is unchecked, so that
OPENBook will not leave mail on the server. If you do not
check this item, the next two items will be unavailable
(grayed out).

Delete old email from server (ALT+D)

If you choose to leave your email messages on the server,
you should eventually delete them. Use this checkbox to
configure OPENBooOk to delete messages after a predefined
number of days. If you check this box, the next item, in
which you tell OPENBook how many days to use, becomes
available. The default is unchecked.

Delete mail after xx days (ALT+A)

Use this field to tell OPENBook how often to delete old
messages from the server. The default is 90 days.

User Dialup entry (ALT+Y)

Some people have more than one profile for Internet access.
OPENBook automatically uses the first profile that was
created using your Control Panel's Dial-up Networking
function. If you want to use a different profile, you can select
it here. This item is a combo box, so you can either type the
entry or use the arrow keys to select the one you want.



Note that if you have a LAN connection, you may not see
anything in this box.

If you don't have a LAN connection and nothing appears in
this box, that probably means you do not have an
established connection to the Internet. This can also occur if
you are using certain free online services. Some services
require you to start their program first. Once you have
started that type of service, you can then log on using
OPENBook's email. You will need to get an account with an
ISP (Internet Service Provider) and then use your computer's
Dial-up Networking function to Add a New Connection.

Once you have successfully added the connection, the
connection name will show up in this field.

Automatic disconnect after send or receive (ALT+R)

Select this checkbox to have OPENBook disconnect from
the Internet as soon as you have completed sending or
receiving your messages. This can be valuable if you have
to pay access charges for the actual time you are online, or if
your modem line is also your phone line. The default is
unchecked.

Note: You must save the settings if you want this information
to be available the next time that you run OPENBook. If you
want these settings to come up automatically when you run,
OPENBook you must save the user settings using Default as
the settings name. This will overwrite the Default settings
with your modifications.

How to Start Email



Once you have your modem and ISP account correctly set
up, and have entered the appropriate Email Settings
information, you can use all of OPENBook's email features.

To open the email system, go to the Tools menu (ALT+T
from OPENBooK's editor) and select Email, or press function
key F5 from anywhere in .OPENBook This will take you to
the Email System screen and place your cursor either in the
Inbox folder (if you have no messages in your Inbox) or in
the message list at the most recent message in your Inbox.
When it lands in the Inbox folder, OPENBook will say "Email,
folder, Inbox."

Note: OPENBOoOK is telling you that you are in the Inbox
folder. We will explain folders in more detail in the next
section, in the part titled "Folder, Inbox." If you have
messages in your Inbox, it will say "Subject and then
proceed to speak the subject line of the most recent
message".

The Email System Screen

The Email System screen contains the list of messages in
the current folder, which is usually the Inbox. It also contains
many buttons and commands that enable you to read, write,
and organize your messages.

OPENBook puts all its new messages in the Inbox.
Whenever you download messages into your computer, the
messages get put in the Inbox in the order they were sent.
The most recent message will be at the top of the list.

The message list takes up most of the screen. In addition to
the message list, there are a number of buttons on this
screen. These buttons allow you to read messages, store



them, compose new messages, and do other things. The
buttons are in a column down the right side of the screen.

You can use the TAB key to move from item to item in the
Email System screen. You can use SHIFT+TAB to move
back to a previous item. Each item also has an accelerator.
An accelerator is a command you can use to activate an item
directly, without needing to go through a menu or needing to
TAB to each function. We will list each item in the order you
would TAB to it, and then we will describe each item briefly.

The tab order of the items is:
= |nbox folder

= Message list

» Read button

= Delete button

= Compose button

= Check for Email button
» Mark Unread button

= Move to Folder button
= Add Folder button

= Rename Folder button
» Delete Folder button

= Address Book button

= Close button

Not all of the items will be available when you first go into
Email. For example, if you have no messages in your Inbox
yet, the buttons to Read and Delete messages will be grayed
out. The TAB key will jump right over these buttons without



landing or speaking them. When you do get messages, all
those buttons will become active.

Folder, Inbox (ALT+F)

OPENBook automatically puts all new messages in the
Inbox. The Inbox is actually a folder, one of several folders
OPENBooK uses to store email messages. OPENBook puts
all messages you send in the Outbox folder. You can create
other folders to store messages in. Note that OPENBook's
email system will always open to the Inbox folder item.

Message list (ALT+M)

This is the list of messages that have been downloaded. (It
is actually a list of all messages in the current folder. Since
the email system starts in the Inbox folder, it is the list of
messages in the Inbox.) The first time you run the email
system, there are no messages in the Inbox, so the message
list is empty. When you TAB around the screen, OPENBook
will skip this item since there is nothing in it.

Read (ALT+R)

Use this button to read the message that is highlighted (or
selected) in the message list. When you select Read,
OPENBook overlays a new screen on top of the Email
System screen. This is the Read Message screen. The
Read Message screen contains the message header
information, sometimes called the message envelope,
several buttons, and the message text. Later in this chapter,
we will show you how to move around in the Read Message
screen.

Delete (ALT+D)



Use this button to delete the message that is highlighted (or
selected) in the message list. OPENBook will delete that
message and put the highlight selection on the next
message in the list.

Compose (ALT+P)

Use this button to compose a new message. When you
select Compose, OPENBook overlays the Compose
Message screen on top of the Email System screen. The
Compose Message screen contains the message header
information, sometimes called the message envelope,
several buttons, and a blank area in which you can write
your message. Later in this chapter, we will show you how
to move around in the Compose Message screen.

Check for Email (ALT+E)

Use this button to download new messages to your Inbox.

When you select Check for Email, OPENBook connects to
the Internet through your modem or network, looks for new
messages, and transfers them into your Inbox.

Mark Unread (ALT+U)

Use this button to mark a selected message as unread. This
can be helpful if you have read a message but want to read it
again. Since OPENBook can move through the list of
unread messages, skipping the ones you have already
opened, marking a message as unread will help separate it
from the rest of the messages.

Move to Folder (ALT+V)

You can create folders to store your saved email messages
more efficiently. The Move to Folder button allows you to



move a message to a different folder. When you select
Move to Folder, OPENBook brings up a dialog box that lists
all the available folders. You should first put your cursor on
the message you want to move, and then TAB to the Move
to Folder button or press ALT+V. You can then use the
arrow keys to select the folder in which you want to store the
selected message.

Add Folder (ALT+A)

You can create folders to store your saved email messages
more efficiently. When you select Add Folder, OPENBook
brings up a dialog box with a blank field for you to type in the
name of a new folder. You can use any characters,
including spaces, in the folder name.

Rename Folder (ALT+N)

Use this button to rename a folder that you have already
created. Note that you cannot rename the Inbox or Outbox
folders.

Delete Folder (ALT+L)

Use this button to delete a folder that you have created. This
will also delete all the messages contained in the folder.
Note that you cannot delete the Inbox or Outbox folders.

Address Book (ALT+B)

OPENBook contains an address book so that you can keep
a list of important email addresses. The address book is tied
to the Compose Message and Read Message screens for
convenience. When you select Address Book, OPENBook
brings up the Address Book dialog box. This dialog has



several buttons and edit fields. Later in this chapter, we will
show you how to use the address book.

Close (ALT+C or ESC)

Use this button to close the email system and return to
OPENBook's browser/editor.

How to Download Messages

The first thing you will probably want to do is download your
messages. Downloading means the process of transferring
new messages from the email server, where they are stored
until you ask for them, into your computer. Remember that
you must have a working connection to the Internet to
download messages.

Press F5 or go to the Email item in the Tools menu. This
brings up OPENBook's email system. Now TAB to the
button labeled Check for Email, then press ENTER. If you
prefer, you can just press ALT+E.

The email system will use your computer's Internet
connection to check for new messages. If you did not tell
OPENBook to save your password, it will prompt you for your
password now. It will then download the new messages into
the Inbox. It will tell you its progress along the way, including
how many messages it is downloading. When it is finished
downloading all the messages, it will disconnect from the
Internet (unless you selected in the Email Settings page to
keep the connection open after downloading).

Now that your messages are there, let's explore them.

Moving Around in the Message List



The message list is a grid that contains information about
each message in the current folder. If you have already
downloaded some messages, they will be listed in the
message list in the Inbox. All unread messages are
displayed in bold type. All messages that have been read
are displayed in normal type. The message list includes the
following categories: subject, sender, status, and date. The
subject is on the left, and the date is on the right. In addition,
there is a vertical scrollbar on the right side of the message
list for mouse users.

When you go to the message list, the subject of the first
message is highlighted and spoken. You can move across
the categories or down the list using the arrow keys. For
example, if you want to look at the sender for each message,
you can press the right arrow once to go to the Sender
column, then press the down arrow to hear the sender for
each message. When you get to the one you want, simply
press the ENTER key and OPENBook will open that
message.

If you have more messages than fit on one screen, you can
press PAGE DOWN to move to the next screen of the
message list. You can also use a mouse to drag the
scrollbar on the right edge of the message list.

You can also move through the list only landing on unread
messages. This is a useful time saver, especially if you have
lots of messages already in the Inbox. To do this, press the
SHIFT key while you press the arrow keys. OPENBook will
advance to the next unread message, skipping over the
messages you have already read.

The following is a description of each category in the
message list.

Subject



The Subject is the title that the sender gives the message.
Subjects can be short or long. The subject area in the
message list is a fixed width, so very long email subjects will
be cut off visually. All message subjects, regardless of how
long they are, will be spoken completely.

Sender

This field contains the name or email address of the person
who sent the message. If the sender has designated his
name instead of his email address, the name will show up as
the sender. If not, the email address will be listed.

Status

This column has only two options: Read and Unread. As
you review the message information, this status will tell you
whether you have read each message or not. If you have
already read a message, but you want to flag it to be sure
you read it again, you can use the Mark Unread button. The
selected message will then be marked Unread and will
appear in bold type.

Date

The date that OPENBooK displays is the date the message
was received in your message server (the POP3 server).
The information in this field includes both the date and the
time. In its default mode, OPENBook uses 12-hour time.
You can switch to 24-hour time using the "Time displayed as
24 hour" checkbox in the Email Settings page.

How to Read Messages



Now that you have looked at the list of downloaded
messages, you will want to read them. To read any
message, put the cursor on the message in the list using the
arrow keys, then press the ENTER key. You can also press
ALT+R to execute the Read message command. If you use
a mouse, you can double-click the left mouse button to open
a message.

When you open a message, OPENBook overlays a new
screen on top of the Email System screen. This is the Read
Message screen. The Read Message screen has two
sections: the header information (also called the message
envelope), on the top part of the screen, and the message
contents, on the bottom two-thirds of the screen. In addition,
OPENBooK's status bar at the very bottom of the screen
displays the number of lines and pages in the open
message.

Your cursor will land on the first word of the message text,
and OPENBook will start reading the message automatically.
Press the Speak key to pause reading, just as you do in the
rest of OPENBook.

To move between the message text and the message
header, press SHIFT+TAB (because once you are in the
message body, the TAB key actually inserts a TAB in your
message) or click the left mouse button. Once you are in the
header area, you can use TAB or SHIFT+TAB to move from
field to field.

The message header contains seven buttons and six
addressing fields.

The fields are:

= From
= To



= Cc

Subject
Date Sent
Attachments

The buttons are:

= Reply

= Reply All

= Forward

= View Attachment

= Save Attachment

= Add to Address Book
= Close

Note that when you press SHIFT+TAB from the message

text, you will land on the first button, the Reply button, not

the To address field. To move to the address fields, press
TAB or SHIFT+TAB several times.

Following is a description of each field and button in the
message header area. Although OPENBook lands first on
the buttons, we will discuss the address information first.

From (ALT+F)

This field contains the name or email address of the person
who sent you the email message.

To (ALT+O)



This field contains the names or email addresses of all the
people this message was sent to.

Cc: (ALT+:)

This field contains the names or email addresses of all the
people who were copied on this message.

Subject (ALT+J)

This field contains the subject name as typed by the person
who sent the message. If the message was forwarded to
you, the subject line will begin with the characters RE:
followed by a space.

Date Sent (ALT+N)
This field contains the date and time the message was sent.

Attachments (ALT+M)

If there were any files attached with the message, they will
be listed here. If there were no files attached, this field will
be grayed out.

The rest of the items in the header area are buttons.

Reply (ALT+R)

Select this button to reply only to the sender of the message,
and not the rest of the people it was originally sent to. When
you select Reply, OPENBook displays the Compose
Message screen, inserts the sender's name in the To field,
inserts the characters RE: at the beginning of the Subject
line, and puts your cursor at the beginning of the message
text area. The original message is displayed below your



cursor with a separator. Note: When replying, if there was a
file attached to the original message, it will not get attached
to the message reply.

Reply All (ALT+P)

Select this button to send your reply to everyone listed in the
To field of the message. When you select Reply All,
OPENBook displays the Compose Message screen and
inserts all the original To and Cc names in the To field. It
also inserts the characters RE: at the beginning of the
Subject line, and puts your cursor at the beginning of the
message text area. The original message is displayed below
your cursor with a separator. Note: When replying, if there
was a file attached to the original message, it will not get
attached to the message reply.

Forward (ALT+W)

Select this button to forward the message to another person
or people. When you select Forward, OPENBook displays
the Compose Message screen and puts your cursor in the
To field so that you can enter the names or addresses of the
people you want to forward the message to. It also inserts
the characters FW: at the beginning of the Subject line.
When Forwarding a message, if there was a file attachment
in the original message, this attachment will also be sent with
your forwarded message.

View Attachment (ALT+V)

Select this button to look at attachments that came with the
email message. You can choose which attachment to view
by putting the cursor on the appropriate attachment file
name, then selecting View. If there are no attachments with
the message, this button is grayed out. This button may also



be grayed out if OPENBook does not recognize the file type
of the attachment.

Save Attachment (ALT+E)

Select this button to save attachments that came with the
email message. You can choose which attachment to save
by putting the cursor on the appropriate attachment file
name, then selecting Save. If there are no attachments with
the message, this button is grayed out.

Add to Address Book (ALT+K)

Select this button to add an email address to your personal
address book. This will add the address of the person who
sent you the message. When you select this item,
OPENBook displays the New Address dialog box, inserts the
address into the Email Addresses field, and puts your cursor
in the Name field. Later in this chapter, we will discuss the
address book in more detail.

Close (ALT+C or ESC)

Use this button to close the open message and return to the
Email System screen.

How to Compose Messages

Now that you have learned how to download and read
messages, you will want to write some messages. To do
this, from the Email System screen, select the Compose
button or press ALT+P (the accelerator for Compose).
When you select Compose, OPENBook overlays the
Compose Message screen on top of the Email System
screen. The Compose Message screen contains the



message header information (also called the message
envelope), several buttons, and a blank area in which you
can write your message. Your cursor will land in the To field.
You can use TAB and SHIFT+TAB to move from field to
field.

The message header contains the following fields:

= To

= Cc

= Bce
Subject
Attachments

There are also five buttons on the right side of the message
header. These buttons are:

Send

Attach File

Delete Attachment
Address Book
Cancel

Following is a description of each field and button in the
order it appears in the message header area. Note that as in
the Read Message screen, when you are in the message
body, the TAB key actually inserts a TAB in your message.
To move from the message text to the message header,
press SHIFT+TAB or press F6. \When you press
SHIFT+TAB or F6 from the message text, you will land on



the first button, which is the Send button. First is the header
information.

To (ALT+O)

Write the names or email addresses of all the people you
want to send this message to. You can enter names directly
from the address book if you want. Refer to the section on
the Address Book for further information. You must separate
each name or address with either a semi-colon (;) or a
comma (,). OPENBook will recognize either of these as
separators. Note that it's not necessary to include a space
between addresses. You can enter either the person's
actual email address or, if the person is in your address
book, you can simply use the name you assigned to that
person.

Cc (ALT+:)

Write the names or email addresses of all the people you
want to copy this message to. You can enter names directly
from the address book if you want. Refer to the section on
the Address Book button for further information. You must
separate each name or address with either a semi-colon (;)
or a comma (,). OPENBook will recognize either of these as
separators.

Bcc (ALT+B)

Write the names or email addresses of all the people you
want to send blind copies of this message to. These names
will not show up on anyone else's copy of the message. If
the regular recipients (those in the To and Cc fields) reply to
the message, the Bcc recipients will not be included in the
reply list. You can enter names directly from the address
book if you want. Refer to the section on the Address Book



button for further information. You must separate each
name or address with either a semi-colon (;) or a comma (,).
OPENBook will recognize either of these as separators.

Subject (ALT+J)
Write the subject for your message in this field.

Attachments (ALT+M)

If you attach any files to the message, they will be listed
here.

The rest of the items in the header area are buttons.

Send (ALT+S)

Select this button to send your completed message. When
you select Send, OPENBook will connect to the Internet
(unless you are already connected) and send the message.
You will receive verbal status prompts during the process.
You can press the ENTER or ESC keys to cancel the
process. Once you have successfully sent your message, a
copy of it will be automatically put in the Outbox folder. You
can check this folder contents by going to the Folder item in
the Email System screen, then pressing the DOWN ARROW
until you reach the folder called Outbox. Press the ENTER
key and OPENBook will display the list of files you have
sent.

Note: OPENBook cannot save a draft of your message, so if
you don't send the message, it won't be saved anywhere.

Attach File (ALT+A)



Select this button to select a file to send with your message.
When you select Attach File, OPENBook brings up the
Attach File dialog box. This dialog box works the same way
the File Open dialog box works in OPENBooK's editor. It has
all the same controls, except it has a button called Attach
instead of the button called Open. You can TAB or
SHIFT+TAB through the selections and use the arrow keys
to move through the folder and file lists. When you find the
file you want to include, make sure the cursor is on it, then
press the ENTER key. OPENBook will attach the file to the
message and list the file name in the Attachments field.

Note that, as with most other Windows programs, if the file is
in use, OPENBook will not be able to attach it.

Delete Attachment (ALT+D)

Select this button to delete a file from the attachment list.
When you select Delete Attachment, OPENBook will not ask
you to confirm the deletion. It will delete the highlighted file
and announce that it has been deleted from the list.

Note: The file has not been deleted from your computer; it
has just been detached from this email message.

Address Book (ALT+K)

Select this button to bring up OPENBook's address book.
You can select names you have saved in your address book
so that you don't have to type them in every time you send a
message. When you select Address Book, OPENBook will
bring up the Address Book dialog box, highlight the first entry
in the list, and put your cursor on the Address To button. If
you want to use that address, simply press ENTER.
OPENBook will insert the name into the To field of your
message. You can use the arrow keys to go through your
list of names and addresses. Separate buttons exist for



adding the name to the To, Cc, and Bcc fields. We will
describe the Address Book dialog in more detail in the next
section, "Using the Address Book."

Cancel (ALT+C or ESC)

Use this button to discard the message without sending it,
and return to the Email System screen. When you select
Cancel, OPENBook asks you to confirm your cancellation.

Using the Address Book

An email address book is a powerful tool for organizing the
names and addresses of people you frequently communicate
with. OPENBook's address book has some added features
that make it useful for visually impaired people.

You can get to the address book in several ways. Because it
is an important tool, it is available from all the email display
screens. From the main Email System screen, you can use
the Address Book button to manage your list of addresses.
From the Compose Message screen, you can select the
Address Book button to easily insert addresses into your
message. From the Read Message screen, you can select
the Add to Address Book button to add an address to the
address book.

You can define not only individual addresses, but also
groups of people. For example, if you often want to send
messages to all the people in your department at work, or to
a certain group of friends, you can put these people in a
group. You give the group a unique name, such as
Marketing Department, or Church Friends, that will help you
select the right group later. This will save you time, since
you won't have to enter each name separately when you
send a message.



Let's add an address to the address book from the Email
System screen. Use the TAB key to go to the Address Book
button, or press ALT+B to go directly to the address book.
OPENBook takes you to the address book dialog box and
places your cursor on the New Entry button. If you press the
ENTER key now, OPENBook will take you directly to the
New Address dialog box where you can type in the name
and address.

The Address Book dialog box contains a grid with the list of
addresses, plus buttons for New Entry, Edit Entry, Delete
Entry, and Close. Below is a brief description of each
function.

New Entry (ALT+N)

Select this button to add a new entry to your address book.
When you select New Entry, OPENBook takes you to the
New Address dialog box, where you can type in the name
and address. The New Address dialog has three fields:
Name or Group, in which you type the name of the person or
group; Email Addresses, in which you type the person's
complete address; and Add Address to Group, in which you
can add an existing address to a pre-defined group. The
Name and Address fields are edit boxes, so you need to type
the information in them. If you are creating a group, you will
type all the addresses in the Email Addresses area,
separating addresses with a comma or semi-colon. You can
type as many addresses as you want in the Email Addresses
area. The Group field is a list box, which means you cannot
type in it. You can only select from the list of existing
addresses. Use the arrow keys to review the names in the
list, then press the SPACEBAR to add the selected address
to group name in the Name or Group field.



Edit Entry (ALT+E)

Select this button to edit an address or group you have
already entered in your address book. You should first move
your cursor to the name or group that you want to change,
then TAB to the Edit Entry button or press the ALT+E
accelerator. OPENBook will bring up the Edit Address dialog
box with the information of the entry you selected. This
dialog is identical to the New Address dialog, but with the
selected name and address already inserted in the
appropriate places. When you are done making changes,
press the ENTER key or select the OK button. You can
cancel the changes by pressing ESC at any time.

Delete Entry (ALT+D)

Select this button to delete a name or group you have
entered in your address book. You should first move your
cursor to the name or group you want to delete, then TAB to
the Delete Entry button or press ALT+D. OPENBook will
ask you to confirm the deletion.

Close (ALT+C or ESC)

Use this button to close the address book and return to the
Email System screen.



Page Layout

What is Page Layout?

It is often useful to know the layout of the elements on a
printed page, such as how many columns and headings
there are, and whether there are pictures, captions, headers,
or footers on the page. OPENBook can collect that
information and report it to you when you ask for it. We call
that Page Layout Description. Several OPENBook functions
exist to help analyze and describe the different elements on
a page. In addition, you can navigate from element to
element. If you have the Logitech WingMan” Force
Feedback Mouse connected, you can also get tactile
feedback about each page element. All the page layout
functions boil down to two needs: the need to have the page
described, and the need to navigate based on the
description.

Overview

Below is a brief overview of each function.

Note: Before you can scan documents for page layout
analysis, you must configure certain items in Scanning
Settings and General Settings. We will discuss those items
later in this chapter.

Note: Page Layout commands use CTRL and SHIFT plus
another key.

Page Layout Summary. Press CTRL+SHIFT+Y to hear a
summary of the layout of the current page. The summary



will tell you how many of each element type are on the page,
such as: 1 header, 2 columns, 1 graphic, 1 caption, 6 text
blocks, and 1 footer.

Announce Page Layout during Reading. Set this item in
General Settings to have OPENBook announce each
element as it comes to it during reading.

Guided Layout Mode. Press CTRL+SHIFT+F5 to have
OPENBook walk you (and your tactile mouse) through the
page elements in logical reading order, announcing each
element as it encounters it.

Explore Layout Mode. Press CTRL+SHIFT+ENTER to
control the movement from element to element while hearing
what each element is. You get the same information in
Explore and Guided Modes, but in Guided Mode, the
program guides your movement, while in Explore Mode, you
control your own movement.

Navigate Using Elements. Press CTRL+SHIFT+DOWN
ARROW or CTRL+SHIFT+UP ARROW to move to the next
or previous element on the page.

What are Page Layout Elements?

Page layout includes identification of the following elements:
= Columns

» Headings

» Text Blocks

= Graphics

= Captions

= Tables

» Headers



= Footers

OPENBook doesn't always agree with you about what
constitutes a header, or whether an area of text is one or two
text blocks. And it doesn't always get the reading order right.
We have added new technology to get as accurate as
possible, but analyzing the elements on a page can
sometimes be a difficult task for a computer.

Below is a brief summary of how OPENBook determines
each of the page elements:

Column: A vertical block of text with the same left and right
margins that has some separation between it and other
vertical blocks of text.

Text Block: A rectangular section of text that should be
treated as one section.

Heading: A line or two of text that is separated by extra
blank lines before and after, or that has different font, size, or
attributes.

Graphic: A rectangular area on the page that does not have
printed text in it but is not blank.

Caption: Several lines of text that appear directly under a
graphic.

Table: A rectangular block of text that is divided into a row
and column presentation.

Header: A line of text at the very top of the page.
Footer: A line of text at the very bottom of the page.



Using the Logitech WingMan® Force
Feedback Mouse

You can add a new dimension of touch to your OPENBook
experience with the Logitech WingMan® Force Feedback
Mouse, also called a "tactile mouse." This mouse was
developed by engineers at Immersion, who worked with the
OPENBook engineers to integrate the tactile mouse with
OPENBook. The WingMan mouse was designed to give
tactile feedback during computer operation. When you use
the WingMan mouse with OPENBook's Page Layout
functions, you will get unique tactile feedback for each
element type. For example, as you move through a text
block you will feel a washboard effect, as though the tactile
mouse were bumping over the lines of text. As you move
from one column to another, you will feel resistance at the
edge of the column. Graphics have a texture like a window
screen.

It is important to note that you can use and benefit from
Page Layout functions whether you have a tactile mouse, a
regular mouse, or no mouse at all. The same goes for visual
feedback with a monitor. The primary feedback mode is
audio: you will get verbal feedback whether you have a
monitor or not. The monitor and mouse do not give more
information about the page; they simply give feedback in
additional sensory modalities.

Page Layout Settings

Several items in the Settings menu need to be turned on so
that OPENBook will collect page layout information.
Collecting this information makes the recognition part of
scanning take longer, so you should only turn the items on if



you think you will need page layout information for a
particular page. Some of the items are in the General
Settings property sheet, and some are in the Scanning
Settings property sheet. You can get to both property sheets
from the Settings menu.

The Scanning Settings item is:

Keep Page Layout Elements. This is the function that tells
OPENBook to keep track of the page layout elements when
it is scanning the page. This item is not checked in default
mode. Note that when this item is checked, it also turns on
two other items: Keep Exact View and Recognize
Columns.

The General Settings items are:

1. Announce Page Elements. This item allows
OPENBook to announce each page element as you come to
it during reading. This item is checked in default mode.

Note that elements are announced using the Menu Voice, so
we have set the Menu Voice to a different setting from that of
the Reading Voice.

2. Page Layout Delay. This item tells OPENBook how
long to pause before advancing to the next element in
Guided Layout Mode. The values are Shorter, Normal, and
Higher. The default is Normal.

3. Tactile Mouse Strength. This item controls the
amount of resistance you get from the tactile mouse in
Guided Layout Mode and Explore Layout Mode. The values
are Low, Medium, and High. The default is Medium.

How to use Page Layout Description



Guided Mode

The first mode, Guided Layout Mode, walks you through the
page elements in logical reading order, announcing each
element along the way. OPENBook moves the cursor
(pointer) to each element while giving you positional
information about each element.

Explore Mode

The second mode, Explore Layout Mode, allows you to
control the movement from element to element while hearing
what the element is. The user moves the cursor to each
element (using either a mouse or keyboard commands) and
OPENBook then announces it.

Both modes display the entire page in Exact View. Both
modes spotlight the entire element as OPENBook moves to
the element (the default spotlight color is yellow, but you can
set it to a different color by changing the Cursor Background
Color in the Visual Settings property page).

OPENBook will give you simultaneous visual and audio
feedback about each element in both modes.

If you have a tactile mouse connected, OPENBook will give
you unique tactile feedback for each element type.

Guided Layout Mode

The command to go to Guided Layout Mode is
CTRL+SHIFT+F5. You can also use the menu to go to
Guided Layout Mode by pressing ALT+T for the Tools menu,
then G for Guided Layout Mode.

When you issue this command, OPENBook switches the
visual display to Exact View at a magnification level that



displays the entire page on the screen. It moves the mouse
pointer (and the tactile mouse, if you have one) to the first
element on the page and announces what the element is
and which occurrence of the element this is. After a brief
pause, it moves to the next element and announces it. It
announces the elements using the Menu Voice. In this way
it moves through the entire page. For example, if you have
scanned a document with two columns, a picture, a header,
a footer, and several blocks of text, OPENBook might say,
"Header 1, Column 1, Text Block 1, Graphic 1, Text Block 2,
Column 2, Text Block 3, Footer 1."

Several commands are available in Guided Layout Mode:

» To pause the Guided Layout Mode, press the Read key
(the ENTER key on the keypad).

» To continue moving from element to element, press the
Read key again.

= To go to Explore Layout Mode, press any key or click the
left mouse button. When you go to Explore Layout Mode,
you can do other things that we will describe below.

» To leave Guided Layout Mode and return to your previous
cursor position on the page, press the ESC key.

Explore Layout Mode

The command to go to Explore Layout Mode is
CTRL+SHIFT+ENTER. You can also use the menu to go to
Explore Layout Mode by pressing ALT+T for the Tools
menu, then X for Explore Layout Mode.

When you issue this command, OPENBook does the same
basic things it does in Guided Layout Mode. It switches the
visual display to Exact View at a magnification level that
displays the full page, and it moves the mouse pointer to the



first element on the page. But this is where the similarities
end. In Explore Layout Mode, it doesn't automatically
announce the elements. It waits for you to move the mouse
around on the screen. As you move the mouse to each
element, OPENBook announces the element. You do not
need to click a mouse button: OPENBook can tell when the
mouse pointer hovers over each element. If you have a
tactile mouse, you will receive tactile feedback as you move
to each element. If you do not have a mouse connected,
you can move sequentially from element to element by
pressing CTRL+SHIFT+DOWN ARROW or
CTRL+SHIFT+UP ARROW.

Several commands are available in Explore Layout Mode.

» To read the text contents of the current element, press the
Read key (the ENTER key on the keypad) or click the left
mouse button.

= To pause or continue reading the contents of the current
element, you should also press the Read key.

» To abandon reading the contents of the current element,
press any key (except ENTER, ESC, or the Read key).

» To leave Explore Layout Mode, press the ESC key.

» To leave Explore Layout Mode and place your cursor at
the beginning of the current element in the browser/editor,
press the ENTER key on the keyboard (not the Read key)
or double-click the left mouse button.

Page Layout Hotkeys

Below is a list of all the element types that can be selected
for navigation, along with their keyboard accelerator. Use
these to select which element you want to use for navigating
the page. Once you have selected the active element, then



use CTRL+SHIFT+DOWN ARROW and CTRL+SHIFT+UP
ARROW to move from element to element. Note that all
page layout commands consist of the CTRL key plus the

SHIFT key plus another key.

Select Headers
Select Columns

Select Section Headings
Select Text Blocks

Select Pictures
Select Captions
Select Tables
Select Footers

Select All Elements

CTRL+SHIFT+D
CTRL+SHIFT+C
CTRL+SHIFT+H
CTRL+SHIFT+B
CTRL+SHIFT+P
CTRL+SHIFT+N
CTRL+SHIFT+T
CTRL+SHIFT+O
CTRL+SHIFT+A

List of All Page Layout Commands

Page Layout Summary
Enter Guided Layout Mode from editor

CTRL+SHIFT+Y
CTRL+SHIFT+F5

Exit Guided Layout Mode and returnto  ESC

previous position in editor
Enter Explore Layout Mode from editor

Enter Explore Layout Mode from Guided

Layout Mode

Exit Explore Layout Mode and returnto  ESC

previous position in editor
Exit Explore Layout Mode and place

CTRL+SHIFT+
ENTER

ENTER

ENTER



cursor at current element in editor

Pause/Resume Reading elements in
Guided Layout Mode

Read Element Contents/Pause
Reading/Resume Reading element
contents in Explore Layout Mode

Go from Exact View to Text View
Move to next element

Move to previous element

Make All Elements the active element

Make Section Headings the active
element

Make Text Blocks the active element
Make Headers the active element
Make Columns the active element
Make Pictures the active element
Make Captions the active element
Make Tables the active element
Make Footers the active element

An Exercise using Page Layout

Read key (on
keypad)

Read key (on
keypad)

CTRL+SHIFT+V

CTRL+SHIFT+
DOWN ARROW

CTRL+SHIFT+
UP ARROW

CTRL+SHIFT+A
CTRL+SHIFT+H

CTRL+SHIFT+B
CTRL+SHIFT+D
CTRL+SHIFT+C
CTRL+SHIFT+P
CTRL+SHIFT+N
CTRL+SHIFT+T
CTRL+SHIFT+O

To give you a better idea of how all this works, let's go
through a hypothetical page that has been scanned using
page layout. We'll imagine that you are using the two-



column document we described above. You can have
OPENBook give you a summary of the page elements;
describe the entire page to you using Guided Layout Mode;
explore the page layout yourself using Explore Layout Mode;
or go from one mode to the other. We'll have you start by
hearing the page layout summary.

Start with Page Layout Summary

To hear a summary of what elements are on the page, press
CTRL+SHIFT+Y from the editor. OPENBook will tell you
there are 2 Columns, 1 Header, 3 Text Blocks, 1 Graphic,
and 1 Footer. Once you have heard this overview of the
page, you will want to hear the page elements in their logical
reading order. To do this, go to Guided Layout Mode.

Go to Guided Layout Mode

Press CTRL+SHIFT+F5 from the editor to go into Guided
Layout Mode. OPENBook will switch to Exact View and
begin announcing the page elements while advancing the
mouse pointer to each element. At some point during this
guided tour, you may want to leave Guided Layout Mode and
go to Explore Layout Mode. To do so, press the keyboard
ENTER key (not the Read key on the keypad).

Go to Explore Layout Mode and Explore the Page

If you just pressed the ENTER key while you were in Guided
Layout Mode, you will now be in Explore Layout Mode. (You
can also go to Explore Mode directly with the
CTRL+SHIFT+ENTER command, or by going to the Tools
menu, ALT+T, then pressing X.)

Let's suppose OPENBooK has just announced that it is at
Text Block 2, the second text block on the page. You want
to see what comes next on the page, so you press
CTRL+SHIFT+DOWN ARROW or move the mouse to go to
the next element. OPENBook will tell you that you are now



at Column 2. Again you want to see what comes next, so
you press CTRL+SHIFT+DOWN ARROW again.
OPENBook tells you that you are at Text Block 3.

Read the Contents of an Element while in Explore
Layout Mode

You now decide you want to know what is in Text Block 3.

To do this, press the Read key on the keypad. OPENBook
will read the text block from beginning to end and spotlight
the entire thing. When it gets to the end of that element, it
will stop reading.

Move through the Page

You can use CTRL+SHIFT+DOWN ARROW and
CTRL+SHIFT+UP ARROW to move through the page,
element by element. You can ask OPENBook to read the
contents of any element you land on (except pictures, of
course). If you want to stop reading the element, press the
ESC key and OPENBook will stop reading, but keep you in
Explore Layout Mode. If you find an element that you want
to edit or spell check, you can go directly to OPENBook's
reader/editor at any time by pressing the keyboard ENTER
key or double-clicking the left mouse button.

Leave Page Layout Mode and Return to the Editor

If you decide you want to leave Page Layout entirely and
return to the editor, press the keyboard ENTER key (not the
Read key). This will take you to your regular level of
magnification, out of Page Layout Mode, and into either Text
View or Exact View, whichever you were in last. It will place
your cursor (and spotlight) on the word it was just reading. |t
will say, "Out of page layout mode, in read-only (or edit)
mode, Page 1, Column 2, Text Block 3." If you were in Exact
View before doing Page Layout functions, you can stay in
Exact View, or press CTRL+SHIFT+V to toggle to Text View,
where you can edit.



This is a useful way to explore the layout of the page and
then jump directly to the place you are most interested in.
Note that if you press the ESC key instead of the ENTER
key, OPENBook will still take you to the editor, but your
cursor will be where you left it before you entered Page
Layout Mode. This will often be the beginning of the page.

Navigate by Page Elements while in the Editor

While you are in the editor, you can still get page layout
information. As OPENBook reads your page in its normal
fashion, it will also announce the page elements as it comes
to them. You can also navigate from element to element
using CTRL+SHIFT+DOWN ARROW and CTRL+SHIFT+UP
ARROW.

Read in the Editor while Announcing Page Elements

Let's go back to our two-column page. Let's put the cursor at
the beginning of the page, and then press the Read key.
OPENBook will announce "Header 1" in the Menu Voice,
and then read the contents of header 1 in the Reading voice.
Next, it will say "Column 1, Text Block 1" in the Menu Voice,
and begin reading the contents of that first text block. In this
way it progresses through the page, announcing each
element and then reading what's in the element.

Change the Active Element for Navigation

So far we have been navigating from element to element,
announcing each element regardless of what type of element
itis. You can select a different active element, such as
Headings, to have OPENBook move from heading to
heading when you press CTRL+SHIFT+DOWN ARROW or
CTRL+SHIFT+UP ARROW. To select Headings as the
active element for navigation, press CTRL+SHIFT+H. Then
when you go through the page with CTRL+SHIFT+DOWN
ARROW, it will only stop at the headings. You can press the
Read key to read the heading, and then press



CTRL+SHIFT+DOWN ARROW again if it's not the one you
want. This can be very useful when you want to get a quick
idea of what topics are addressed on the page. Or you can
select Text Blocks as the active element. This will let you
read just the meat of the page, skipping all headers, footers,
captions, etc. To select Text Blocks as the active element,
press CTRL+SHIFT+B. To go back to OPENBook's default
element type, press CTRL+SHIFT+A, for All Elements. In
this default mode, OPENBook moves from element to
element regardless of which type of element it encounters.



Customizing OPENBook

The Settings Menu allows you to save, retrieve, or delete
settings files, or modify OPENBook's Speech, Visual,
Scanning, Email, Advanced, and General settings.
Whenever you start OPENBooKk it loads the settings file
called Default.

Note: If you want OPENBooK to load your favorite settings
each time you run the program, you should save them in the
Default settings file. We'll tell you how to do that below in
the description for the Save the Settings menu item.

The following settings dialogs are available:
» Speech Settings

» Visual Settings

= Scanning Settings

» Email Settings

= Advanced Settings

» General Settings

These dialog boxes are called "property pages.” There is
one page for each of the six categories. These pages
include many different settings options. In addition, there are
four elements shared by all six property pages. They are:

The Preview Box

This area, located on the right side of the property pages,
contains part of a famous literary speech. In this area,
OPENBook demonstrates the speech and visual changes
that you have selected.

OK button



This button saves the selected settings and closes the
property pages. You can also do this by pressing the
ENTER key.

Cancel button

This button closes the property pages without saving the
settings. You can also do this by pressing the ESC key.

Apply button

This button saves the selected settings but does not close
the property pages, allowing you to continue to make
modifications to other settings.

Once you open one property page, you can access any other
property page by using the tabs at the top of the property
page you're on. You can reach these headings by using the
TAB key to get to the title of your current property page, then
using the Left and Right arrow keys to move to other
Property pages.

Settings Menu [ALT+G]

Save the Settings

Select this menu item to save the current settings. When
you want to keep the changes to your Speech, Visual,
Scanning, Email, Advanced, or General settings, you must
save these changes in a settings file. Otherwise, the next
time you use OPENBook it will return to the original settings.
When you select Save the Settings, OPENBook opens the
Select Settings File list. Use the arrow keys to select a
settings file or create a new settings file. If you choose an
existing settings file, OPENBook will ask you to confirm that
you want to overwrite any previous settings saved in that file.



If you choose to create a new file, OPENBook will give you
the opportunity to name that file.

If you want your favorite settings to be loaded each time you
run OPENBook save them in the Default settings file. This
will overwrite the Default settings with your favorite settings.
Since that file already exists, OPENBook will ask you to
confirm that you want to overwrite the file. Don't be afraid to
do this. If you ever want to go back to using the factory
default settings, go to the menu item called Retrieve the
Settings, and select the file called Factory default settings.
That file cannot be changed or deleted, so it will always be
available to you.

Retrieve Settings

Select this menu item to retrieve saved settings files,
including the Default file (the one OPENBook loads
whenever it starts) and the Factory default settings file (the
original factory settings), as well as any settings files you
have named yourself. When you select Retrieve the
Settings, OPENBook opens the Select Settings File list. Use
the arrow keys to select a settings file. Once you retrieve the
file, the settings saved in that file are activated.

Delete Settings

Select this menu item to delete saved settings files. When
you select Delete Settings, OPENBook opens the Select
Settings File list. Use the arrow keys to select a settings file.
OPENBook will ask you to confirm your deletions. Note: you
cannot delete the Default settings file.



Speech On [CTRL+F5]

Select this item to determine whether OPENBook speaks
aloud or not. This menu item is checked by default on
startup. To check or uncheck this item, move to the item on
the menu, then press ENTER.

Speech Settings

Select this item to open the Speech Settings property page.
This allows you to determine the type of voice, volume, pitch,
and inflection of OPENBook's speaking voice.

Visual Settings

Select this item to open the Visual Settings property page, to
change the way OPENBookK presents text on the screen.

Scanning Settings

Select this item to open the Scanning Options property page,
which enables you to control the way OPENBook scans
pages.

Speech Settings Dialog Box

Voice Selection list field

To select the voice you wish to modify, type in your selection
or use the arrow keys. You have three options:

» Reading Voice, the voice OPENBook uses to read aloud.
= Menu Voice, the voice OPENBook uses to read menus.



= Emphasis Voice, the voice OPENBook uses to read
emphasized text, like bold, underline and italics.

Emphasis text is not displayed in OPENBook but it is
retained, so it can be helpful to set your Emphasis voice
slightly to be different from the Reading voice. Some people
like to set the Emphasis voice to a slightly higher pitch or
volume.

Once you have selected the voice you wish to modify, use
the following options to alter that voice. Later, you can return
to Voice Selection, and choose another voice to modify.

Apply Settings to All Voices check box

Tells you whether this box is checked or unchecked. When
this box is checked, OPENBook applies the changes you
have just made to all three voices (Reading, Menu, and
Emphasis).

Voice Name list field

Lists voices used by OPENBook The speech software
shipped with OPENBook has five voice options. (Other
speech synthesizers may have a different number of
options.) Type in your selection or use the arrow keys.

Voice Rate list field

To select how fast OPENBook reads, type the first digit of a
number, or use the arrow keys.

Voice Volume list field

To select how loud OPENBook reads, type the first digit of a
number, or use the arrow keys.

Voice Pitch list field

To select how high or low OPENBooK reads, type the first
digit of a number, or use the arrow keys.

Voice Inflection list field



To select how much inflection OPENBook uses, type the first
digit of a number, or use the arrow keys. This option may
not be available with some speech synthesizers.

Voice Punctuation list field

To determine how much punctuation OPENBook announces,
type the first letter of your selection, or use the arrow keys.
Your choices are:

= All (OPENBoOK speaks every period and comma).

= Some (OPENBook speaks the less common punctuation
but not periods and commas).

= None (OPENBook does not speak any punctuation).

This option may not be available with some speech
synthesizers.

Voice Language list field

To select which language OPENBook uses when reading,
type in your selection or use the arrow keys. You must be
using a multilingual speech synthesizer, or this option will not
be available.

Key Echo During Editing list field

To tell OPENBook to speak your typed keystrokes out loud
when you are Edit Mode, type in your selection, or use the
arrow keys. This spoken "echo" of your keystrokes allows
you to hear your typing as you type. You have four options:

» Character: Speaks every keystroke as you type.

= Word: Speaks only completed words; that is, it speaks the
word you just typed as soon as you type punctuation or a
space after it.

= Both: Speaks both the keystrokes as you type and the
final completed word after you type it. This is useful for
beginning typists or with material you are proofreading.



= Off: Does not echo any keystrokes. Your typing will be
silent, except, of course, for the click, click, and click of
your keyboard.

Test button

Tests the voice settings you have selected before applying
them. To stop testing, simply press ENTER, or select this
button again.

Announce Capital Letters While Typing

Select this checkbox to have OPENBook say "cap" before
each upper-case letter while you are typing. The default for
this item is unchecked.

Visual Settings Dialog Box

Font

Determines the type and size of font used for text on the
page.
Font Name

To select the type of font used for text on the page, use the
arrow keys.

Font Size list field

To select the size of font used for text on the page, use the
arrow keys.

Colors

Determines the color of the on-screen text and background,
plus the cursor text and background.

Text Color list field
To select the text color, use the arrow keys.



Background Color list field

To select the color for the background of your document (the
part that's not text), use the arrow keys.

Cursor Text list field

To select the color for text within OPENBook's cursor (or
spotlight), use the arrow keys. Remember that when you are
in Read-only Mode, the cursor will spotlight the current word.
Therefore, the Cursor Text color will be the color of the text
in the current word. You can also change the spotlight from
word to line, sentence, or paragraph, using the Movement
Unit menu item in the General Settings property page. Note
that the default might not be the first color on the list, so you
may need to use the up arrow key to get to the color of your
choice.

Cursor Background Color list field

To select the color for the background of text within
OPENBook's cursor (or spotlight), use the arrow keys.
Remember that when you are in Read-only Mode, the cursor
will spotlight the current word. Therefore, the Cursor Text
color will be the color of the text in the current word. You
can also change the spotlight from word to line, sentence, or
paragraph, using the Movement Unit menu item in the
General Settings property page. In that case, the spotlight
will encompass the line, sentence, or paragraph as you read.
Note that the default might not be the first color on the list, so
you may need to use the up arrow key to get to the color of
your choice.

Side Margins

Adjusts the amount of blank space at the right and left sides
of the page. In all cases, larger numbers means more
space.

Left Margin list field



To increase or decrease the size of the margin, use the
arrow keys.

Right Margin list field

To increase or decrease the size of the margin, use the
arrow keys.

Extra Spacing

Adjusts the amount of space between characters, words,
lines, and sentences. This can be an extremely valuable
feature for people with low vision. Increasing the amount of
space between these text elements can help you distinguish
between one word and the next, or can help you track to the
next line more easily. With all elements, the larger the
number you enter, the more space between the elements.

Character list field

To increase or decrease the amount of space between
characters, use the arrow keys.

Word list field

To increase or decrease the amount of space between
words, use the arrow keys.

Line list field

To increase or decrease the amount of space between lines,
use the arrow keys.

Sentence list field

To increase or decrease the amount of space between
sentences, use the arrow keys.

Scanning Settings Dialog Box

Scanning Mode list field



Scanning Mode is one of the most important and frequently
used items, since you may want to scan one page in
Orientation Only, then the next in Scan and Read, then a
bunch more in Large Batch mode. Therefore, we have given
you other ways to get to the Scanning Mode list while you
are in your document. From anywhere in the document, you
can press SHIFT+F10 to bring up the Scanning Mode list. If
you are a mouse user, simply click the right mouse button.
To select one of several different ways to scan, use the
arrow keys.

Scanning Mode options include:
Scan and Read

Scan and Read lets you first scan a page, then read it. This
is the standard setting -- when you first use OPENBook your
scanning options are set to Scan and Read. This setting is
best for quickly reading short documents, such as letters
and recipes.

Scan in Background

Scan in Background lets you scan one page while reading
another. The document you are scanning may be the same
as the document you are reading, or you may scan into one
document, then open and read another.

To scan and read within the same document, choose Scan
in Background, and then scan a page, and read it. While
OPENBook reads the page, you'll hear a small musical tone,
your signal that OPENBooOK is ready to scan another page.
Place a second page on the scanner, then press the Scan
key. OPENBook will continue to read while the second page
is being scanned.

To scan one document and read another, choose Scan in
Background. Begin scanning pages into a document and,
while OPENBook is scanning, open another document and



read it. The musical tone will notify you to scan another
page. Scan in Background is the best setting when you want
to read and scan at the same time.

Note: This mode is not recommended unless you have a
hardware synthesizer, such as DECtalk PC or

DECtalk Express. Otherwise, speech is interrupted during
scanning.

Large Batch

Large Batch lets you divide the scanning process into two
parts:

= Scanning the page
» Processing and Recognizing the page

Scanning requires your participation to turn the pages. But
Processing and Recognition -- the lengthier procedures --
can be done by the PC without your involvement. Using
Large Batch, you can scan all the pages of a large document
-- like a book -- then instruct OPENBook to process the
pages while you do something else. You don't have to be
present during the processing step.

Large Batch gives you several options:
= Scan a group of pages, then immediately process them

= Scan a group, come back later and scan more, then
process them

= Scan a group, then process them at a later time.

If you are using an Automatic Document Feeder (ADF), the
process is even more automated. You can place batches of
20 to 25 pages in the ADF, and scan them as a group.
Please note that if you are using 2-page scanning with an
ADF, you must scan the backs of the pages in reverse order
so that OPENBook can match them up correctly.

Batch in Background



Batch in Background allows you to begin Large Batch
scanning, and while you are scanning, open and read a
document. While reading the document, you will
occasionally be interrupted to hear the standard Large Batch
Scanning prompts.

Note: This mode is not recommended unless you have a
hardware synthesizer, such as DECtalk PC or DECtalk
Express. Otherwise, speech is interrupted during scanning.

Express Batch

Express Batch is a simpler version of Large Batch scanning.
While Large Batch gives you prompts when it has completed
scanning and is ready for another page, Express Batch skips
these prompts. You must listen for the sound of the scanner
head reaching the bottom of the flatbed and returning to the
top. In those few seconds it takes to do this, place a new
page on the scanner. The scanner keeps scanning, over
and over again, until you press ESC. Just as with Large
Batch, once scanning is completed, OPENBook will
recognize the pages while you do something else. You can
also suspend scanning, or cancel the entire Express Batch
process. Express Batch is best used by a person who's
familiar with their scanner, and wants to scan a large
document quickly. Do not use this mode with an ADF.

Image Only

Image Only scans the page and saves it as an image file,
without performing the recognition process. This setting is
useful if you wish to create an image file to be faxed later or
used as a graphic.

Fax Files

Fax Files allows you to recognize files that you have
received via a fax card. For the best possible recognition, be
sure to get a fine fax image of 200 x 200 dpi, and save the



file in PCX, DCX or TIF format. When you choose this
scanning mode, you will need to tell OPENBook where to
find the file you wish to recognize.

Orientation Only

Orientation Only scans a page and determines its orientation
without proceeding to the recognition process. This setting
is useful when you are scanning a large document. You can
use Orientation Only to determine the orientation of the first
page, and then set the Page Orientation to the correct
setting. This will speed up the scanning process.

Express Batch in Background

Express Batch in Background permits you to quickly add
pages to a document while reading earlier pages of the
same document.

For example, You have scanned and processed the first
chapter of a book. You want to batch scan the second
chapter, but also want to read that which you worked on
earlier. Open the document of interest and begin reading.
With the Scanning Mode set to Express Batch in
Background, press the scan key and the scanner will acquire
new pages as reading continues. The scanner will scan
repeatedly so that you will not have to press the scan key for
each successive page of text. It will pause in accordance
with the Batch Scan Delay that is set in the Scanning
Options menu. You may continue to turn pages and scan for
as long as you wish until you reach the end of the previously
scanned portion of the document. At this point, reading will
stop as unprocessed pages are encountered. Scanning will
continue until you hit the Scan Key again to stop it.

Following scanning, you will be given the opportunity to
process the newly added batch.

Scanning Contrast list field



To control the dark-to-light contrast ratio in the scanned
document, use the arrow keys or type the first letter of the
selection. You have several choices:

= Automatic Contrast. OPENBook will individually
evaluate each page to determine the best contrast setting
for maximum accuracy. This is useful if you have mystery
pages to scan. This is the easiest setting but it adds to
the scanning time.

= Normal Contrast. This corresponds to a value of 127.
This setting will work for most books and memos, or
anything else that has reasonably good black print on
white paper.

= Darken Page is useful when the print on the page is too
light. When OPENBook reads a light page, letters seem
to "break up." An example of this is when OPENBook
reads "iii" instead of the letter "m."

» Lighten Page is a good choice if the letters are becoming
"glued together." An example of this is when OPENBook
reads the letter "m" instead of the letters "r" and "n."

= Custom contrast choices include a series of numbers
from 0 to 255. Custom contrast settings can increase
accuracy if you have a page that is outside the range of
the other options. Low numbers make it darker, and high
numbers make it lighter. The Normal setting corresponds
to the value 127.

Page Orientation list field

To select the orientation of the page on the scanner, use the
arrow keys. While the Automatic setting is usually best, if
you are doing a number of pages for which you already know
the orientation, using the correct orientation setting will
speed up the scanning process. You have five orientation



choices (the instructions are for HP scanners -- other
scanner orientations may vary):

= Automatic lets OPENBook determine which way the page
is situated on the scanner. This is the easiest setting but
it can add slightly to the scanning time.

= Normal means the top of the page is flush with the rear
edge of the scanner's glass plate.

» Sideways means the top of the page is flush with the right
side of the scanner's glass plate.

» Upside-down means the top of the page is flush with the
front edge of the scanner's glass plate.

» Sideways Upside-down means the top of the page is
flush with the left side of the scanner's glass plate.

Scanning Resolution list field

Controls how fine the scanner makes a picture of the page.
Many scanners have a standard setting of 300 dots per inch.
However, if you are reading pages printed in very small type
and have a scanner that can resolve as finely as 400 dots
per inch, you may see improved recognition accuracy. For
400 dpi to be effective, your scanner must have an optical
resolution of at least 400 by 400 dip. An optical resolution of
300 by 600 dpi is not adequate. The point range for fonts
with a 300 dpi scanner is 6 to 24 points; for a 400 dpi
scanner, the range is 4 to 24 points. To select the scanner
resolution, use the arrow keys. Note: Depending upon your
scanner, you may have only one choice in this menu.

Recognize columns check box

Determines how OPENBook will scan, save, and present
your document for reading. When Recognize Columns is
checked, OPENBook saves and reads all of column one
first, then column two, and so on. If it encounters tables,
OPENBook is smart enough to automatically present them



properly. When Recognize Columns is not checked,
OPENBook will scan, save, and present the entire page as
though there are no columns. Most of the time column
recognition is the best choice. When you start OPENBook
this box is checked and Recognize Columns is on.

Color Scanning check box

Determines whether OPENBook scans in color or in black
and white. When checked, OPENBook will scan all colored
text, art, and photographs in color. If you do not have a color
scanner installed, OPENBook will tell you that color scanning
is not possible. Color scanning and recognition is a much
slower process than the standard black-and-white scanning,
so we recommend that you only use this item when you
know you have something you want to save in its original
color presentation. Additionally, the results of Color
Scanning are only apparent while you are in Exact View, so
you must have Exact View checked to use Color Scanning.
Also note that you can only do color scanning at 300 dpi
resolution. When you start OPENBook this box is
unchecked and Color Scanning is off.

Keep Exact View check box

Tells OPENBook to save two versions of any scanned page:
the image file (the actual picture of the page) and the text file
(the recognized text from the page). Since an image file can
be very large, we recommend that you only save this version
of the page if you will be reading the page in Exact View.
When you start OPENBook this box is unchecked and Keep
Exact View is off.

2-Page Scanning check box

Allows OPENBook to scan two side-by-side pages of an
open paperback book (or other book in which both facing
pages fit on the scanner) in a single scan. OPENBook will
automatically read the first page first, and then read the



second page. When you start OPENBooK this box is
unchecked and 2-Page Scanning is off. This setting lets
OPENBook do even better when scanning an OPENBook

Page Description

Select this checkbox to have OPENBook collect page
description elements when it scans a page. Page
description elements are headers, footers, columns,
headings, text blocks, tables, and pictures. When you scan
a document with Page Description checked, you can use
OPENBooK's page layout features to find out how many of
each item are on the page, and what order they are in. This
can be very useful for getting an idea of what is on the page.
OPENBook takes longer to recognize pages when it is
collecting page description elements, therefore the default
setting for this item is unchecked.

De-skew check box

Corrects as much as ten degrees of skew in a crooked page,
straightening up to three quarters of an inch for a standard
eight-and-a-half inch page. Use this option if you are
concerned that the page is on the scanner slightly crooked,
or skewed. It is also helpful when reading documents that
have been photocopied, since the text may not be perfectly
straight on the page. However, de-skewing will add a few
seconds to the scan time. When you start OPENBooKk this
box is checked and De-Skew is on.

De-speckle check box

Corrects for a page that doesn't have a clean, clear
background, such as a page that has been photocopied
several times, newspapers, or text on paper with speckled
shading on it, such as colored newsprint or magazines.
When you start OPENBook this box is checked and De-
Speckle is on.



White on Black check box

Allows OPENBook to scan and recognize white text on a
black background. This is useful when reading packaged
food boxes or magazines that often use light text on a dark
background for emphasis. When you start OPENBook this
box is checked and White on Black is on.

Language Analyst check box

Improves accuracy on difficult pages. However, this feature
may slow the recognition process. When you start
OPENBook this box is checked and Language Analyst is on.

Discard Blank Pages check box

Check this box if you want OPENBook to throw away
scanned pages that are blank. Note that sometimes you will
want to keep blank pages so that you can maintain the
original page numbering and order. The default is
unchecked.

Emphasis Text check box

Tells OPENBook to indicate words that were emphasized on
the original page -- printed bold, or with italics or underlining
-- by using a different voice. Once you select Emphasis
Text, you should also modify the Emphasis Voice on the
Voice Settings Properties page, so that the voice OPENBook
uses will sound different from the Reading or Menu voices.
Note that even if you have Emphasis Text off, OPENBook
will still retain these attributes and export them when you
save the document for word processing. When you start
OPENBook this box is unchecked and Emphasis Text is off.

Uncertain Text check box

Tells OPENBook to indicate when it encounters a word or
character it is unsure about by using the Uncertain Text
Marker (see next item). When you start OPENBook this box
is unchecked and Uncertain Text is off.



Uncertain Text Marker edit field

To designate a specific character, such as an asterisk, that
will be spoken when OPENBook finds a word or character it
is unsure about, type the character into the box. When you
start OPENBook Uncertain Text is set to Asterisk (*).

Express Batch Delay list field

To set the amount of time between one scan and the next
when scanning in Express Batch, use the arrow keys to
choose between 0 and 25. A larger number gives you more
time to turn the pages. When you start OPENBook Express
Batch Delay is set to 0.

Scanner

Use these items to specify which type of scanner driver you
want OPENBook to use. Several choices exist, depending
on the scanners currently installed in your system.
OPENBook automatically detects the scanner drivers that
are installed on your computer, and it selects the one it
thinks you will want to use as the default. If there does not
appear to be an obvious scanner choice, OPENBook will
display this item the first time you scan a document, and ask
you to confirm the scanner driver selection. Note that we do
not recommend using the HP TWAIN driver unless you are
using the scanners listed, due to its slow speed.

TWAIN Properties

If you are using the Unknown TWAIN driver selection in the
Scanner field, you can fine-tune OPENBook's operation with
your scanner. Note that you should not use the "Unknown
TWAIN" choice unless the other choices do not work with
your scanner.

Three items exist for this. All three are checkboxes. The
default setting for each item is unchecked. You should only



select an item if you are having problems that you think one
of these items will solve.

The first item is called "Allow scanner to finish when
canceling a scan." If you are unable to scan at all after you
have canceled scanning in the middle of a scan, try this
setting.

The second item is called "Black and white contrast uses
Brightness instead of Threshold." If, when scanning with
Color OFF and Keep Exact View ON, all contrast settings
result in a scan identical to a contrast setting of 255, try this
setting.

The third item is called "Must close TWAIN after each scan."
If your first scan works, but subsequent scans seem to
ignore changes in scanner settings, try this setting.

General Settings

Select this item to open the General Settings property page,
to change OPENBoOkK's general settings.

Tones check box

Controls the beeps that are heard when OPENBooOK is
scanning. When you start OPENBook this box is checked
and Tones are on.

Progress Messages check box

Controls the messages that OPENBook speaks when it is
recognizing the page. When you start OPENBooKk this box is
checked and Progress Messages are on.

Announce Shortcut Keys check box

Announces the menu shortcut keys (for example, CTRL+O
for Open in the File menu) after each applicable menu item.
This helps you learn these shortcuts. When you start



OPENBook this box is checked and Announce Shortcut
Keys is off.

Announce Dialog Controls CTRL+S

Select this checkbox to have OPENBook announce what
type of control each item in a dialog box is. The types are
Button, Edit Box, List Box, Combo Box, Checkbox, Radio
Button, Hotkey Box Control, and TAB Control. The default
for this item is unchecked; that is, OPENBook will not
announce dialog controls.

Always Start in Edit Mode check box

When this item is checked, OPENBooK is in Edit Mode
whenever it is run. When it is unchecked, OPENBooOK starts
in Read-only Mode. Many beginning computer users will
want to start in Read-only Mode, only switching to Edit Mode
when they want to edit something. Other users will always
want to stay in Edit Mode. Regardless of which mode you
start in, you can always switch from one mode to the other.
Use the SPACEBAR to check or uncheck this item. When
you start OPENBook this box is unchecked, so you will start
in Read-only Mode.

Hide Spotlight for Braille Tracking

This item improves cursor tracking for refreshable braille
displays. When OPENBooKk is in Read-only Mode, it uses a
word spotlight in addition to the cursor to identify the cursor
location in a document. This spotlight can help with visual
tracking for partially sighted computer users, but it decreases
the responsiveness of refreshable braille devices.

Therefore, if you have a braille display, you should turn this
item off. The default setting for this item is unchecked.

Announce Page Elements

Select this checkbox to have OPENBook announce page
elements while it is reading a scanned document. To



announce page elements, you must have scanned the page
with Page Description on (you enable Page Description in
Scanning Settings). When you select Announce Page
Elements, OPENBook announces each new page element
as it reads. Examples of page elements are columns,
headers, footers, and text blocks. The default setting for this
item is unchecked.

Use Numeric Keypad for OPENBook Functions

Select this checkbox to give control of the numeric keypad to
OPENBook The default for this item is checked, so
OPENBook will use the keypad for its own functions. [f you
uncheck this item, OPENBook will not control the keypad, so
you can use another program's keypad functions.

Tactile Mouse Strength

This item determines how much resistance the Logitech
WingMan Force Feedback Mouse will give during page
layout description and navigation. The options are Low,
Medium, and Strong. The default is Medium.

Extra Pause After Each Sentence

This item determines the amount of extra time OPENBook
pauses after each sentence. The range is from No Extra
Pause to 3 seconds, in half-second increments, with No
Extra Pause as the default.

Movement Unit list field

This determines the amount of text to be spotlighted in the
cursor area. Use the arrows to choose Word, Sentence,
Line, or Paragraph. When you then use the Speak key to
have OPENBook read continuously, the spotlight cursor will
highlight the unit as OPENBook reads to you. OPENBook
will not stop or pause at the end of each Movement Unit. If
you want OPENBook to read Unit by Unit, use the Control
key with the right arrow key. OPENBook will then stop at



after each Unit and wait for you to press Control plus right
arrow again. This is a useful way to review text for
readability.

Scanning Hotkey

Use this item to specify the key combination that you can
use to scan a document from another program. The key
combination must be CTRL+ALT along with an alphanumeric
key (a letter or a number). The default setting is
CTRL+ALT+S. When you press the scanning hotkey from
outside OPENBook (that is, when OPENBooK is running but
is not the active program), OPENBook will scan the page in
the scanner in Scan in Background mode and place it at the
end of the active document in OPENBook

Default File Location

Use this item to specify where you want OPENBook to save
and retrieve files. You must specify a complete path name,
including the drive, such as C:\MyDocuments. The default
for this item is C:\MyDocuments.

Default File Format

Use this item to specify what you want OPENBook to use as
its default file format. This refers to whether a file is saved
as a Word file, a DOS text file, an Arkenstone file, or another
file type. You must select from the list provided. This does
not mean you can only save OPENBooK files in the formats
in this list; these are just the formats you can specify as the
default. You can always select a different file format in the
File Save As dialog box. The default file format is
Arkenstone Docs (*.ark).

BuckScan Currency edit field

Allows you to choose whether BuckScan will scan and
identify American or Canadian currency (BuckScan is found
in the Scan menu). The default is American currency.



Page Layout Delay

This item tells OPENBook how long to pause before
advancing to the next element in Guided Layout Mode. The
values are Shorter, Normal, and Higher. The default is
Normal.

Menu Level list field

Allows you to choose between Beginner and Advanced
menu levels when using the Classic menu system. This
option only applies to the Classic menu system. It has two
options:

= Beginner level is very straightforward and easy to learn,
but has a limited number of choices.

= Advanced level includes more complex options.

Advanced Settings

Recognize Text Using

Use this item to specify which OCR (Optical Character
Recognition) engine you want OPENBook to use to
recognize scanned text. OPENBook has three OCR engines
to choose from: Caere MTX, Recognita, and Fine Reader.
The default is the Caere MTX engine. When you change
OCR engines, the change will take effect with the next page
you scan.

Text Type list field

To choose between two options, use the arrow keys. Your
choices include Normal Text and Typewritten or Dot Matrix
Text. Pages printed on a Dot Matrix printer or on a
typewriter that doesn't use proportional spacing may not



scan clearly. Selecting Typewritten or Dot Matrix Text may
help OPENBooOk to read these pages more successfully.

Recognition Language list field

To choose which language OPENBook uses to recognize
text, use the arrow keys. This option is useful if the
document you are using has text that contains accent marks,
umlauts, or other characters unique to a particular language.

Secondary Language

Use this item to specify a secondary recognition language
OPENBooK uses to recognize scanned text. OPENBook will
use both the primary and secondary languages to recognize
text. This option is useful if the document you are using has
text that contains accent marks, umlauts, or other characters
unique to a particular language. Note that this does not refer
to the language OPENBook speaks in, rather it refers to the
characters the OCR engine identifies during the recognition
portion of the scanning process. The default for this item is
American English.

Image Format list field

This is the format OPENBook should use to save an image
you scan using the Image Only scanning mode. Your
choices include:

= PCX

= TIFF G3

= TIFF G3 Modified

= TIFF G4

= TIFF Packbits

» TIFF Uncompressed

Left Boundary edit field



Type in the number representing the size of the left
boundary, in inches and fractions of an inch. OPENBook will
ignore anything outside this boundary area.

Right Boundary edit field

Type in the number representing the size of the right
boundary, in inches and fractions of an inch. OPENBook will
ignore anything outside this boundary area.

Top Boundary edit field

Type in the number representing the size of the top
boundary, in inches and fractions of an inch. OPENBook will
ignore anything outside this boundary area.

Bottom Boundary edit field

Type in the number representing the size of the bottom
boundary, in inches and fractions of an inch. OPENBook will
ignore anything outside this boundary area.

A note about using scanning boundaries: These
boundaries determine how much of the page will be
recognized, by defining the distance from the side of the
page, and telling OPENBook to ignore anything outside that
boundary. The standard setting for all four boundaries (left,
right, top, and bottom) is zero, which means that the entire
page will be scanned and recognized. However, if you are
reading a book and wish to delete the header (which repeats
the title of the book on each page), try defining a top
boundary of one inch. You'll need to experiment on each
book to get the correct setting. Setting the boundary might
also be useful when reading utility or phone bills. If the
amount due is always located in the same spot, you could
define boundaries to recognize only that area.

Automatically Apply OCR Corrections

Select this item to have OPENBook automatically apply the
OCR Correction words to documents when they are



scanned. OPENBook has an OCR Corrections feature that
allows you to specify text string replacements for words the
OCR engine has not correctly identified. If you will be
scanning types of documents that you know OPENBook has
had trouble identifying, you should check this box so that you
don't have to go through your scanned documents to apply
corrections manually. The default setting for this item is
unchecked.

Email Settings
Sending Mail

Name (ALT+N)

You must tell OPENBook what name is listed for this
connection. This name will appear whenever you send an
email. It will be your "formal name." Usually this will be your
first and last name.

Email Address (ALT+E)

Enter your complete email address. This address will follow
a standard format: your user name followed by the @ (at)
sign followed by the name of the Internet service you use. It
will look something like this:

yourname@mindspring.com.

Note that we are referring here to your user name, not your
formal name. Although they could be the same, they are
usually different: the user name is often a shortened version
of your formal name. Thus, your formal name could be
"Jane Doe" while your user name could be "jdoe" or many
other possibilities. Sometimes your ISP (Internet Service



Provider) chooses your user name, and sometimes you get
to select one yourself.

SMTP Server (ALT+S)

The SMTP Server is the outgoing mail server address. It will
probably look something like this:

smtp.mindspring.com

although some servers use "mail" instead of "smtp" in the
address.

Settings for Receiving Email

User Login Name (ALT+U)

This is your email name without the ending part. For
example, if your email address is
yourname@mindspring.com, then your user login name is
yourname. This information is in the Servers page in Mail
and Fax Properties, in a field called Account Name.

Password (ALT+P)

Every Internet account has a password to protect your
privacy. Passwords are usually five to eight characters long.
OPENBook like most programs, represents each character
visually by an asterisk. In addition, OPENBook does not
speak the characters as you type them or review them.
These things are done so that other people cannot learn
your password.

Save Password (ALT+V)

You can check this box to tell OPENBook to save and
remember your password so that you don't have to enter it
every time you log on. Your password is saved in an
encrypted format so you don't have to worry about others
finding out your password.



The default setting (the setting when you first start
OPENBook for this item is unchecked.

POP3 Server (ALT+3)

The POP3 Server is the incoming mail server address. It will
probably look something like this:

pop3.mindspring.com

although some servers use "mail" or other text instead of
"pop3" in the address.

Time displayed as 24 hour (ALT+T)

OPENBOooK lists the time each mail message is sent or
received. You can have the time displayed in either 12-hour
or 24-hour format. The default is to use 12-hour format.

Leave mail on server (ALT+L)

If OPENBoOK is not the only email system you use, you may
want to leave your incoming email messages on the server.
To do this, check this box. The default is unchecked, so that
OPENBook will not leave mail on the server. If you do not
check this item, the next two items will be unavailable
(grayed out).

Delete old email from server (ALT+D)

If you choose to leave your email messages on the server,
you should eventually delete them. Use this checkbox to
configure OPENBook to delete messages after a predefined
number of days. If you check this box, the next item, in
which you tell OPENBook how many days to use, becomes
available. The default is unchecked.

Delete mail after xx days (ALT+A)

Use this field to tell OPENBook how often to delete old
messages from the server. The default is 90 days.

User Dialup entry (ALT+Y)



Some people have more than one profile for Internet access.
OPENBook automatically uses the first profile that was
created using your Control Panel's Dial-up Networking
function. If you want to use a different profile, you can select
it here. This item is a combo box, so you can either type the
entry or use the arrow keys to select the one you want. Note
that if you have a LAN connection, you may not see anything
in this box. If you don't have a LAN connection and nothing
appears in this box, that probably means you do not have an
established connection to the Internet. This can also occur if
you are using certain free online services. Some services
require you to start their program first. Once you have
started that type of service, you can then log on using
OPENBook's email. You will need to get an account with an
ISP (Internet Service Provider) and then use your computer's
Dial-up Networking function to Add a New Connection.

Once you have successfully added the connection, the
connection name will show up in this field.

Automatic disconnect after send or receive (ALT+R)

Select this checkbox to have OPENBook disconnect from
the Internet as soon as you have completed sending or
receiving your messages. This can be valuable if you have
to pay access charges for the actual time you are online, or if
your modem line is also your phone line. The default is
unchecked.

Note: You must save the settings if you want this information
to be available the next time that you run OPENBook If you
want these settings to come up automatically when you run
OPENBook you must save the user settings using Default as
the settings name. This will overwrite the Default settings
with your modifications.



Other Tools

Change Speech Driver

Select this item on the Tools Menu to use a different speech
synthesizer driver that you have previously installed. People
sometimes refer to this as changing speech drivers "on the
fly." When you select Speech Drivers, OPENBook opens
the Speech Driver list. Each speech driver you installed will
be listed here. If you only installed one speech driver, your
current driver will be the only one listed. Use the arrow keys
to select a driver from the list. When you close this list,
OPENBook will load the driver you selected and begin using
it.

Please note that you will only be able to switch among the
list of synthesizers that was created the last time you ran the
OPENBook installation program. If you have more than one
synthesizer and you want them all to be available here, you
should run the OPENBooKk installation program (Setup.exe)
again and choose "Synthesizer Driver Installation” from the
options. You can install as many synthesizers as you want,
but you must have the driver files for each (except ViaVoice
Outloud, which is included with OPENBook). Also note that
you cannot switch between different Microsoft SAPI
synthesizers.

List of Launchable Programs

Select this menu item to launch other Windows applications,
such as Microsoft Word or Word Perfect. You select the



programs to be listed here during installation. When you
launch an application using this feature, the new program
opens and becomes the active program. OPENBook does
not close, but remains open in the background.

To move between open programs: while holding down the
ALT key, press the TAB key to cycle through the available
open applications. You may need to press TAB more than
once to cycle through all available programs. When you
reach the application you want to access, simply release
both keys, and that application will become the active one.



Low Vision Features

Special Features for Low Vision
Users

This version of OPENBook includes many benefits specially
designed for low vision users. As you learn more about how
OPENBook works, pay special attention to the following
features:

<Exact View lets you scan and display a page on the screen
exactly as it is in the original document. This includes any
graphics, line art, tables, columns, and other elements
that affect how the page looks. While in Exact View, you
can read the page, change text and background colors,
and zoom in and out, but you cannot edit the text. To
make modifications, you must switch back to Text View.
This feature is only available for scanned pages, not for
text or word processing files. Note: when you open a
previously scanned document, it will open in Text View.
You can find this item on the View menu.

-Zoom allows you to change the display of the scanned page
shown in Exact View. You can zoom from 25% of normal
size to 500% of normal size. You can find this item on the
View menu.

Low Vision Menu

You can use OPENBook's Low Vision Menu to quickly cycle
through the most common settings for Size, Colors, Fonts,
and Spacing.



Low Vision Menu [ALT+L]

Go to the Low Vision Menu by pressing ALT+L, and then use
the arrow keys to select one of the items. This opens the
Low Vision Shortcuts dialog box, which appears in the lower
third of the screen. Each item in the menu has a large,
color-coded button.

Use the TAB key or the or arrow keys to move from button to
button, then press the SPACEBAR to change the setting for
that item. The visual display will change instantly. For
example, go to the Size button and press the SPACEBAR
several times. Each time you press SPACEBAR,
OPENBook increases the font size and says "larger." When
you get to the upper limit for each item, OPENBooKk tells you
(for example, it says "largest" for font) and then cycles back
to the beginning of the list ("smallest").

You can also use SHIFT+SPACEBAR to go backwards
through the settings.

The Customize button takes you directly to the Visual
Settings dialog box, where you can fine-tune the visual
settings.

Size (ALT+S)

Use this button to change the font size that OPENBook will
use to display documents on the screen. Press the
SPACEBAR to change the setting. You can also press
ALT+S or SHIFT+ALT+S to change the Size setting. There
are seven settings available from this button. If you want a
size not included in the button settings, you can use the
Customize button to go to Visual Settings and fine-tune the
font size.



Colors (ALT+0O)

Use this button to change the foreground and background
color combinations for text and cursor that OPENBook will
use to display documents on the screen. Press the
SPACEBAR to change the setting. You can also press
ALT+0 or SHIFT+ALT+0O to change the Colors setting.
There are eight color combinations available from this
button. If you want a color combination that is not included
in the button settings, you can use the Customize button to
go to Visual Settings and select the colors you want.

Fonts (ALT+F)

Use this button to select the font that OPENBook will use to
display documents on the screen. Press the SPACEBAR to
change the setting. You can also press ALT+F or
SHIFT+ALT+F to change the Fonts setting. There are six
fonts available from this button. If you want to use a font that
is not included in the button settings, you can use the
Customize button to go to Visual Settings and select the font
you want.

Spacing (ALT+P)

Use this button to select the amount of spacing that
OPENBook will put between letters, words, sentences, and
lines on the screen. Press the SPACEBAR to change the
setting. You can also press ALT+P or SHIFT+ALT+P to
change the amount of spacing. There are six spacing
settings available from this button. If you want to use
spacing that is not included in the button settings, or if you
want to set the letter, word, sentence, and line spacing
independently, you can use the Customize button to go to
Visual Settings and select the spacing choices you want.



Customize (ALT+T)

Select this button to go directly to the Visual Settings
property page, where you can fine-tune the visual display
properties.



Appendices

Detailed Installation Instructions

OPENBooK's Installation program talks, making it easy for
you to hear the prompts. When you first start the Installation
program, OPENBook runs a test to see if you have a screen
reader. If you do, OPENBook will then give you the choice
of running the program with your own screen reader, or using
the standard OPENBook talking Installation program.

To navigate through the Installation dialog boxes, generally
use the ENTER key, which selects the most likely option in
each section. You can also use the TAB key to move from
element to element, cycling through all the options until you
return to the first one. To move backwards through the
elements, hold the SHIFT key, and then press the TAB key
to cycle backward through the options.

To hear an entire dialog box read, hold down the CTRL key,
and then press the B key. Once the dialog box begins
speaking you can let go of the B key. To make the
Installation program stop talking, simply press the CTRL key
by itself.

Within each dialog box, you have different options,
depending upon whether the element is a button, check box,
or field (see below). However, at any point in the dialog box,
you can press ESC to cancel and close the dialog box, or
ENTER to choose an item.

Buttons: Press the ENTER key to activate the button, or the
TAB key to move to another element. Dialog boxes usually
have three buttons: Back, Next, and Cancel.



Check Box: Press the SPACEBAR to check the box; press
it again to uncheck the box. Once you have checked or
unchecked the box, press the TAB key to move to another
field or ENTER to advance to the next dialog box.

Radio Buttons: These come in pairs or groups. You must
select one and only one of the options. Click to select the
desired option. Each time you click on a new option, you
automatically select that option and the others are
deselected.

Edit Fields: Type the appropriate text in the field, then press
the TAB key to move to another field or ENTER to advance
to the next dialog box.

Starting the Installation program

To begin the installation procedure:

1. Turn on your PC.

2. Install and turn on your scanner, making sure that it is
unlocked.

3. Have your software serial number handy. The serial
number is located in two places: on the outside of the box
and on the outside of the plastic case that hold the
OPENBook CD.

4. Place the OPENBook CD in your CD-ROM drive.
OPENBook automatically starts the installation process.

Note: if OPENBoOK is already installed, the automatic
process will not start.

If, for some reason, OPENBook does not automatically start
the installation process, follow these steps:



1. With the OPENBook CD in your CD-ROM drive, open the
Windows START menu on the task bar.

2. Select RUN.

3. In the Edit Field, type in the name of your CD drive
(usually d:\), followed by the word SETUP (for example,
d:\setup).

4. Select the OK button in the RUN dialog box, or press the
ENTER key.

You can exit the OPENBook Installation program at any
time, simply by selecting Cancel.

Prompts -- Typical Installation

Once installation begins, follow the prompts to install
OPENBook. These prompts usually include:
Welcome: OPENBook will warn you to close all open
Windows programs, and then will load files needed to
continue the installation.

User Information

OPENBook will ask for your name, company name, and
software serial number.

Software License Agreement

OPENBook will ask you to read and agree to the license
agreement.

Setup Type

OPENBook will ask whether you want to do a typical or
custom installation.



"Typical" installs the standard files necessary to run

OPENBook Hewlett-Packard scanner drivers, and a software
speech synthesizer. If you wish to use a different scanner or
speech synthesizer, you must select the Custom installation.

"Custom" gives you more control over where documents are
stored and which files are installed. It also allows you to
install other scanner and speech synthesizer drivers.

Unless you need to make detailed modifications, we
recommend that you choose the Typical installation.

Installing the OPENBook files

Once you select Typical, OPENBook will install all program
files, and then give you the opportunity to read the README
file. This file gives up-to-date information about the software.
When you are finished reading the README file, press
ALT+F4 to return to the Installation Program. OPENBook
will then ask you to press ENTER to complete installation. In
some cases, you may need to re-boot your computer before
you begin using OPENBook

If you have any difficulties running OPENBook after you
have installed it, check the chapter in this manual titled
Frequently Asked Questions, to see if we address your
problem.

Prompts -- Custom Installation

If you need more control over which components are
installed and where, choose "Custom Installation. Once you
select Custom, OPENBook presents the following installation
options:

Synthesizers



Although OPENBook includes its own software speech
synthesizer, Custom Installation lets you select one or more
speech synthesizers from a list. Make your choices by using
the SPACEBAR.

You can also install a separate speech synthesizer at a later
time. It is not necessary to have a speech synthesizer to
install OPENBOOK..

All scanners other than ViaVoice Outloud, which is included
with OPENBook require their own hardware and/or software
installation. Consult your synthesizer's manual.

Launchable Applications

OPENBook will identify certain launchable applications on
your hard drive, such as word processing programs and
Grade 2 Braille transcription programs. If you choose, these
applications will appear on your OPENBook menu, and you
can open them while using OPENBook You can also
configure launchable applications at a later time.

Destination Folders

OPENBook will ask you to confirm the proposed location for
the OPENBook files on your hard drive. If you wish the files
to be saved to a different location, you can type that location
in the Destination edit field.

Review of Choices

OPENBook will present you with a list of identified
selections, including speech synthesizers, scanners,
launchable applications, and file destinations, and ask you to
confirm. If you wish to change any of the selections, simply
use the Back button to go back to the appropriate dialog box,
and make your changes.



Installing the OPENBook files

OPENBook will install all program files, then give you the
opportunity to read the README file. This file gives up-to-
date information about the software. When you are finished
reading the README file, press ALT+F4 to return to the
Installation Program. OPENBook will then ask you to press
ENTER to complete installation. In some cases, you may
need to re-boot your computer before you begin using
OPENBOook.

If you have any difficulties running OPENBook check the
chapter titled Frequently Asked Questions, to see if we
address your problem.

Making Changes to OPENBook

It's easy to make changes to OPENBook such as adding a
scanner or launchable programs. Place the OPENBook CD
in your CD-ROM drive, then run the program called Setup
following the steps listed below.

1. With the OPENBook CD in your CD-ROM drive, open the
Windows START menu on the task bar.

2. Select RUN.

3. In the Edit Field, type the name of your CD drive (usually
d:\), followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
ENTER key.

Once installation begins, OPENBook presents a series of
options, including:

= Uninstall current version



= Synthesizer driver installation
= |Launchable application setup
= Scanner installation

Make your selection, and then follow the prompts.

How to Uninstall OPENBook

There are two ways to uninstall OPENBook

If you wish to uninstall and then re-install OPENBook place
the OPENBook CD in your CD-ROM drive. Then run the
program called Setup following the steps listed below.

1. With the OPENBook CD in your CD-ROM drive, open the
Windows START menu on the task bar.

2. Select RUN.

3. In the Edit Field, type the name of your CD drive (usually
d:\), followed by the word SETUP (for example, d:\setup).

4. Select the OK button in the RUN dialog box, or press the
ENTER key.

OPENBook presents a series of options, including:
» Uninstall current version

= Synthesizer driver installation

» |Launchable application setup

= Scanner installation

Select Uninstall and follow the prompts.

If you simply wish to uninstall OPENBook and ViaVoice
Outloud, use the Add/Remove Programs feature in the
Windows Control Panel.



Classic Menus

USING THE KEYPAD

OPENBoOOK was originally designed to be used primarily
with the 17-key numeric keypad, with some functions
duplicated on the rest of the keyboard for laptop computers.
If you have used previous versions of OPENBook you may
feel more comfortable using the keypad.

The typical keypad is usually laid out, from left to right, like
this:

The top row: the NumLock key, the Forward Slash key,
the Asterisk key, and the Minus key.

The second row from the top: Home (#7), Up Arrow (#8),
Page Up (#9), and the top half of the Plus key.

The third row from the top: Left Arrow (#4), #5 (with tactile
underbar or dot), Right Arrow (#6), and the bottom half of
the Plus key.

The fourth row from the top: End (#1), Down Arrow (#2),
Page Down (#3), and the top half of the ENTER key.

The bottom row, fifth row from the top: the Ins key (#0),
the DELETE Key (Decimal point), and the bottom half of
the ENTER key.

Each of these keys has a name and function assigned to it in
OPENBook The OPENBook keys are, from left to right:

The top row:



The NumLock key is the Menu key. This key activates the
Classic-style OPENBook menus that allow you to choose
different options and change OPENBook's settings. The
Menu key is a toggle key: press it to get into the menu, and
press it again to leave the menu. Note: this key will not
access the Windows menus.

The Forward Slash key (/) is the Scanning Status key.
This key indicates the page progress information for a page
that is currently being scanned. If you are not scanning, it
indicates that no page is being scanned. This key is also a
toggle key.

The Asterisk key (*) is the Voice Rate key. This key allows
you to change the speed of the voice while reading a
document. Press Voice Rate key to read faster, or the
SHIFT key (usually just above the far lower left on the
keyboard) to read slower. OPENBook will say "faster" or
"slower."

The Minus key (-) is the Help key. This key will present
you with OPENBook's list of Help Topics, to allow you to
read the manual on-line. This key is also a toggle key.

The second row from the top:

The Home key (7) is the Where Am I? Key. This key
explains where you are in the reading process or in the
menus. Press it while in a menu, and it will tell you what
menu you are in. Press it while in a document, and it will list
the line and page number you are on.

The Up Arrow key (8) is the Move Up key. This key moves
you up one line if you are reading a page, or up one choice if
you are in a menu.

The Page Up key (9) is the Page Up key. This key moves
to the previous page in the document (if there is one). If you



are in a List Field on a menu, it moves you to the previous
group of items in the list.

The Plus (+) is the ESC key. This key exits the current
activity or allows you to leave a menu or Help when you are
finished with it. Note: if you are scanning a page, ESC will
not stop the scanning process. To interrupt scanning, use
the Scan key.

The third row from the top:

The Left Arrow key (4) is the Move Left key. This key
moves you back a word while you are reading. (Note: if you
have changed the Movement Unit, Move Left may move you
back a letter, a sentence, a line, or a paragraph.) To go a
long way back, hold the Move Left key down, and you will
quickly move backward through the page. OPENBook will
not speak the text as you skim through it, but once you stop,
it will say the word the cursor is on. To begin reading again,
press the Speak key.

The Center Key (5) is the Select key. This key selects the
current choice in a menu or in a dialog box. If you are
reading, press this key once and OPENBook speaks the
word the cursor is on. Press it again and OPENBook spells
the word aloud. Press it a third time to spell the word with
the military alphabet, using words like Alpha, Bravo, and
Charlie for the letters A, B and C. The Select key's spelling
functionality also works when you are in a dialog box, to read
and spell information in fields and button names.

The Right Arrow key (6) is the Move Right key. This key
moves you forward a word while you are reading. (Note: if
you have changed the Movement Unit, Move Left may move
you forward a letter, a sentence, a line, or a paragraph.) To
go a long way forward, hold the Move Right key down, and
you will quickly move through the page. OPENBook will not



speak the text as you skim through it, but once you stop, it
will say the word the cursor is on.

To begin reading again, press the Speak key.

The fourth row from the top:

The End key (1) is the Key Describer. This key describes
the function of the other keys. Press this key and the other
keys become inactive; then press any key and OPENBook
will announce the key's name or function. Press the Key
Describer again to return the keypad to its normal function.

The Down Arrow key (2) is the Move Down key. This key
moves you down one line if you are reading a page, or down
one choice if you are in a menu.

The Page Down key (3) is the Page Down key. This key
moves to the next page in the document (if there is one). If
you are in a List Field on a menu, it moves you to the next
group of items in the list.

The ENTER key is the Speak key. This key starts and
stops reading, interrupts speech, or repeats the current item
in a menu or dialog box. The Speak key also works when
you are in a dialog box, to announce button names or
information in fields.

The bottom row (fifth row from the top):

The Insert key (0) is the Scan key. This key starts or stops
scanning.

The DELETE key (.) is the Delete key. This key deletes the
current page you are reading, or deletes a character when
you are typing an entry, such as a file name.



Using The Classic Menu And Numeric
Keystrokes

This manual documents OPENBook as a Windows program,
using a standard Windows menu structure and dialog boxes.
However, if you used a previous version of OPENBook you
may wish to continue using the Classic-style OPENBook
menus. You should be aware that most of OPENBook's new
features are only available through the Windows menu
structure, including the Edit features. Other items may
operate differently in Classic menus. The next section will
list the Classic menu items, in order, along with a description
and the location for the corresponding item on the Windows
menus.

As a Classic menu user, you may also want to continue
controlling OPENBook using the using keypad keys. For
more information using keypad keys, see the next Using
Hotkeys.

The Classic Menus: Advanced menu level

Read a Document (File menu: Open) -- this option opens
and reads a previously named document.

Create a New Document -- this option creates a new
document. You can then scan pages into it.

Scanning Options (Settings menu: Scanning Settings) --
this menu controls how OPENBook scans. There are
several choices on this menu.

Scanning Mode -- this option gives several ways to control
the scanning process. Your choices are:

= Scan and Read -- this is the standard mode: OPENBook
scans the page, then reads it aloud.



= Scan in Background -- this mode scans one page while
you are reading another.

= Large Batch -- this mode divides the scanning process
into Scanning, the step that requires your participation to
turn the pages and Recognition, the step that takes more
time, but can be performed while you do something else.

= Batch in Background -- this mode allows you to scan a
series of pages using Large Batch mode, and while you
are scanning, read another document.

= Express Batch -- Similar to Large Batch, this mode skips
the scanning prompts, allowing you to listen for the sound
of the scanner head reaching the bottom of the flatbed,
and returning to the top.

= Image Only -- this mode scans a page and saves it as an
image file, without performing the recognition process.

» Fax Files -- this mode performs the recognition process
on Fax or other image files.

= Two Page (Note: this item is new to the Classic
Menus) -- this mode scans two side-by-side pages of an
OPENBook in a single scan.

= Orientation only -- This mode scans a page, and
determines its orientation.

Scanning Contrast -- this option allows you to control the
level of contrast in the scanned page. Your choices are:

Automatic Contrast

Normal Contrast

Darken Page

Lighten Page

Custom Contrast



Page Orientation -- this option allows you to select how
OPENBook will handle pages that are upside-down or
sideways. Your choices are:

= Automatic
= Normal

Sideways

Upside Down

Sideways Upside Down

Scanning Boundaries -- this option specifies which
portion of the page should be recognized, by defining the
distance from a specific side of the page, and telling
OPENBooKk to ignore anything outside the boundary area.
You can control four boundaries:

Left Boundary

Right Boundary

Top Boundary

Bottom Boundary

Scanning Resolution -- this option controls how fine a
picture of the page is made by the scanner. Your choices
are:

= 300 dots per inch
= 400 dots per inch

Text De-skew -- this option determines whether the
scanner will compensate for up to 10 degrees of skew on
a page. Your choices are: On/Off

Language Analyst -- this option improves the quality of
text recognition on difficult pages. Your choices are:
On/Off



ScanFix -- this option helps get the best scan possible by
performing additional work on the scanned images. Your
choices are: On/Off

Text Type -- this option allows you to choose between two
types of print formats. Your choices are:

= Normal text
= Typewriter or Dot matrix

Text Flags (Note that in Windows menus, Bold, Italics,
and Underline are grouped under the term Emphasis) -
- this option, when used with a speech synthesizer, tells
OPENBook to indicate words that were emphasized on
the original page by using a different voice for "Bold,"
"ltalic," Underlined," or "Uncertain text." Your choices are:

= Bold text - On/Off

= |talic text - On/Off

» Underlined text - On/Off
= Uncertain text - On/Off

Uncertain text flag -- This option allows you to designate
a specific character, such as an asterisk, that will be
spoken when OPENBook finds a word or character it is
unsure about.

Image Format -- This option allows you to choose into
which format a scanned image will be saved. Most
OPENBook users will use this setting to create Fax
images. Your choices are:

= PCX

= TIFF G3 Modified
= TIFF G3

= TIFF G4

» TIFF Packbits



» TIFF Uncompressed

Recognition Language -- this option lets you choose
which language to use when recognizing text.

Library (File menu: Library) -- this menu allows you to
create new documents, open or close them, save them,
delete them, or open and read document files from many
popular word processing programs. There are several
choices on this menu.

Read a Document -- this option opens and reads a
previously named document.

Create a New Document -- this option creates a new
document and then scans pages into it immediately.

Clos